PCT-SAFE User Reference Manual - PCT-EASY Mode

January 2013
**DISCLAIMER**

By using the PCT-SAFE software, the user acknowledges and agrees that the software is provided “as is,” with no warranties, either express or implied. The International Bureau makes every effort to ensure, but cannot guarantee, the correct operation of the software, including but not limited to the validation functionalities, and makes no warranties or representations in connection with the acquisition and/or use of the software. The International Bureau assumes no liability or responsibility for any errors, omissions, deficiencies or defects in the PCT-SAFE software or in request forms prepared using that software, or for any loss or damage of any nature incurred in connection with the acquisition and/or use of the software. As a result, the content of a request form prepared using the software is the user’s responsibility, and the International Bureau urges users to carefully check the request form preview/printout before submitting it to the receiving Office.

**REMINDER**

PCT-SAFE users are reminded that compliance with any national security prescriptions applicable under national law is the applicant’s responsibility.
Table of Contents

1. INTRODUCTION TO PCT-SAFE ................................................................. 8
   1.1 GENERAL INFORMATION ........................................................................ 8
   1.1.1 The purpose of this User Reference Manual ........................................ 8
   1.1.2 PCT references ...................................................................................... 8
   1.1.3 Updating PCT-SAFE software ............................................................... 8
   1.2 WHAT IS PCT-SAFE? ................................................................................. 8
   1.2.1 Equipment needed .................................................................................. 9
   1.3 CONTACT US ............................................................................................. 9
   1.4 INSTALLING/UNINSTALLING PCT-SAFE ................................................ 10
   1.5 SPECIAL PROVISIONS FOR FILING PCT-SAFE APPLICATIONS ...... 10
   1.5.1 Creating a PCT International Patent Application ..................................... 10
   1.5.1.1 Request, Description, Claims, Abstract, Drawings .............................. 10
   1.5.1.2 Language .......................................................................................... 10
   1.5.2 Filing a PCT International Patent Application ........................................ 10
   1.5.2.1 Where to file? .................................................................................... 10
   1.6 PCT-SAFE — OVERVIEW ........................................................................ 11
   1.7 DEMO / PRODUCTION MODE .................................................................. 11
   1.8 STARTING PCT-SAFE ............................................................................... 11
   1.8.1 PCT-SAFE File Manager folders .......................................................... 11
   1.8.2 The File Menu ....................................................................................... 13
   1.8.2.1 New Form->PCT Form ...................................................................... 13
   1.8.2.2 Export Forms or Address Book ......................................................... 13
   1.8.2.3 Import Address Book or Forms ......................................................... 14
   1.8.3 The Edit Menu ....................................................................................... 14
   1.8.4 The Go Menu ....................................................................................... 14
   1.8.5 The Tools Menu .................................................................................... 14
   1.8.6 The Help Menu ..................................................................................... 15
   1.8.7 PCT-SAFE File Manager Settings (Menu Tools -> settings) .................. 16
       1.8.7.1 User management enabled: “you do not have the appropriate rights to perform this operation” .................................................................... 17
       1.8.7.2 PCT-SAFE FM General (not applicable in PCT-EASY mode) .......... 17
       1.8.7.3 Setting options ................................................................................ 17
       1.8.7.4 Live Update settings ........................................................................ 17
       1.8.7.5 PCT filing ....................................................................................... 18
   1.9 CREATING A NEW REQUEST FORM ...................................................... 20
   1.9.1 What are categories? (Optional) ............................................................. 21
   1.9.2 Accessing categories functionality ......................................................... 22
   1.9.3 Creating/assigning categories ................................................................. 22
   1.9.4 Disassociating/deleting categories .......................................................... 22
   1.9.5 Opening Drafts of PCT Forms ............................................................... 23
       1.9.5.1 Deleting draft forms ....................................................................... 23
       1.9.6 Creating and Using Templates (Optional) ........................................... 24
   1.9.7 Address book ....................................................................................... 27
       1.9.7.1 Adding an address to the Address book .......................................... 27
   1.9.7.2 Viewing Address book contents ....................................................... 29
   1.9.7.3 Importing entries to the Names page ............................................... 29
   2. PCT-SAFE ELECTRONIC REQUEST ....................................................... 30
      2.1 PCT/RO/101 ELECTRONIC REQUEST FORM .................................... 31
      2.1.1 Speed Buttons (icons) ........................................................................ 32
      2.1.2 Previewing and Printing Draft and Duplicate Forms ......................... 32
      2.1.2.1 Preview function ........................................................................... 32
      2.1.2.2 Print function ................................................................................ 32
      2.2 VALIDATION FUNCTION ...................................................................... 33
      2.3 PCT-SAFE REQUEST FORM — MENU BAR BAR FUNCTIONS ........ 35
2.3.1 File (Alt-F) ......................................................................................................................... 35
2.3.2 Edit (Alt-E) .......................................................................................................................... 35
2.3.3 View (Alt-V) ........................................................................................................................ 35
2.3.4 Tools (Alt-T) ....................................................................................................................... 35
2.3.5 Help (Alt-H) ........................................................................................................................ 35
2.4 PCT-SAFE MASTER TABLE FUNCTIONS ............................................................................ 35
2.4.1 Modifying the order of entries on a Page Master Table ..................................................... 35
2.4.2 Deleting an entry on a Page Master Table ........................................................................... 35

3. REQUEST .................................................................................................................................. 36
3.1 REQUEST ................................................................................................................................ 37
3.1.1 Receiving Office .................................................................................................................. 37
3.1.2 International Searching Authority ..................................................................................... 37
3.1.3 Language of filing of the international application ............................................................... 37
3.1.4 Title of invention .................................................................................................................. 38
3.1.5 Request to use results of earlier search ............................................................................... 38
3.1.6 Details of Earlier Search ...................................................................................................... 39
3.1.6.1 Country (or regional Office) (pull-down menu) ............................................................... 40
3.1.6.2 Filing Date ....................................................................................................................... 40
3.1.6.3 Number ........................................................................................................................... 40

4. STATES ..................................................................................................................................... 41
4.1 STATES (DESIGNATIONS (REGIONAL AND NATIONAL PATENTS)) ........................................ 41
4.1.1 Reference to parent application or grant details page .......................................................... 43
4.1.2 OAPI Patent (OA) ............................................................................................................... 44

5. NAMES ...................................................................................................................................... 46
5.1 NAMES (APPLICANT, INVENTOR, AGENT, COMMON REPRESENTATIVE) ............................... 46
5.1.1 Names Master Table ........................................................................................................... 47
5.1.2 Using the Address book ..................................................................................................... 47
5.1.3 Add Applicant (add applicant or applicant/inventor function) .......................................... 48
5.1.3.1 Legal entity/Natural person (radio buttons) .................................................................... 48
5.1.3.2 Name (of legal entity) ..................................................................................................... 48
5.1.3.3 Name (of natural person) ............................................................................................... 48
5.1.3.4 This person is also inventor (check-box) ........................................................................ 48
5.1.3.5 Country or territory ........................................................................................................ 49
5.1.3.6 Address .......................................................................................................................... 49
5.1.3.7 City ................................................................................................................................ 49
5.1.3.8 State/County/Province ................................................................................................... 49
5.1.3.9 Postal code ...................................................................................................................... 49
5.1.3.10 Telephone .................................................................................................................... 49
5.1.3.11 Facsimile ...................................................................................................................... 49
5.1.3.12 E-mail .......................................................................................................................... 49
5.1.3.13 Nationality (Rules 4.5(a) and (b) and 18.1) ................................................................. 50
5.1.3.14 Residence (Rules 4.5(a) and (c) and 18.1) ................................................................. 50
5.1.3.15 Applicant designations (This person is applicant for the purposes of:) ............................ 51
5.1.4 Add Inventor Only (to indicate an inventor only) ................................................................. 53
5.1.4.1 Deceased (check-box) .................................................................................................... 54
5.1.5 Add Agent (to indicate an agent) .......................................................................................... 57
5.1.5.1 Same address as the first-named agent (check-box) ....................................................... 57
5.1.5.2 Who can act as agent? ................................................................................................... 57
5.1.5.3 Manner of appointment of agent .................................................................................... 57
5.1.5.4 Correspondence ............................................................................................................. 57
5.1.5.5 E-mail ............................................................................................................................ 58
5.1.5.6 Power of attorney .......................................................................................................... 58
5.1.6 Add Common Representative (to select an applicant as a common representative) ....... 60
5.1.6.1 Name of Common Representative (pull-down menu) .................................................. 60
5.1.6.2 Manner of appointment of Common Representative ..................................................... 61
5.1.6.3 Correspondence
5.1.6.4 E-mail
5.1.7 Add Special Address for Correspondence

6. PRIORITY

6.1 General Information on Priority Claims
6.1.2 The Priority Page
6.1.3 Details of Priority Claim of Earlier Application
   6.1.3.1 National (radio button)
   6.1.3.2 Regional (radio button/pull-down menu)
   6.1.3.3 International (PCT) (radio button)
6.1.4 Details of Priority Claim of Earlier Application (National)
   6.1.4.1 Country
   6.1.4.2 Filing date
   6.1.4.3 Number
   6.1.4.4 Request copy of priority document from RO (check-box)
   6.1.4.5 Restoration of the Right of Priority (Rules 4.1(c)(v) and 26bis.3)
6.1.5 Details of Priority Claim of Earlier Application (Regional)
   6.1.5.1 Regional Office (pull-down menu)
   6.1.5.2 Filing date
   6.1.5.3 Number
   6.1.5.4 Country party to the Paris Convention for the Protection of Industrial Property for which the earlier application was filed (ARIPO application)
   6.1.5.5 Request copy of priority document from RO (check-box)
   6.1.5.6 Restoration of the Right of Priority (Rules 4.1(c)(v) and 26bis.3)
6.1.6 Details of Priority Claim of Earlier Application (International (PCT))
   6.1.6.1 Receiving Office
   6.1.6.2 Filing date
   6.1.6.3 Number
   6.1.6.4 Request copy of priority document from RO (check-box)
   6.1.6.5 Restoration of the Right of Priority (Rules 4.1(c)(v) and 26bis.3)

7. BIOLOGY

7.1 BIOLOGY (INDICATIONS RELATING TO DEPOSITED MICROORGANISM AND/OR OTHER BIOLOGICAL MATERIAL)
   7.1.1 Details Concerning Indications Relating to a Deposited Microorganism and/or Other Biological Material
      7.1.1.1 Indications in the description
      7.1.1.2 Depositary institution
      7.1.1.3 Address
      7.1.1.4 Accession Number
      7.1.1.5 Date of deposit
      7.1.1.6 Additional Indications
      7.1.1.7 Separate Furnishing of Indications
      7.1.1.8 Designated States for Which Indications Are Made
      7.1.1.9 Sequence listing

8. DECLARATIONS

8.1 PREPARING DECLARATIONS

9. CONTENTS

9.1 CONTENTS (CHECK LIST)
   9.1.1 International Application Master Table (Check List)
   9.1.2 Sequence listings
   9.1.3 The Calculate Button
   9.1.4 International Application Content Details
      9.1.4.1 Request (including Declaration sheets)
      9.1.4.2 Description (excluding sequence listing part)
      9.1.4.3 Claims
      9.1.4.4 Abstract
9.1.4.5 Drawings ................................................................................................................ 90
9.1.4.6 Sequence listing part of description ...................................................................... 91
9.1.4.7 Sequence listing in PCT-EASY EFS-Web mode (for filing with RO/US) .............. 92
9.1.5 Accompanying Items Master Table (Check List) ...................................................... 94
9.1.5 Accompanying Items Master Table (Check List) ...................................................... 94
9.1.5.1 Fee calculation sheet .............................................................................................. 95
9.1.5.2 Priority document (Contents page) (multiple instance) ........................................ 95
9.1.5.3 Original separate power of attorney ..................................................................... 96
9.1.5.4 Copy of original general power of attorney ........................................................... 96
9.1.5.5 Statement explaining lack of signature .................................................................. 96
9.1.5.6 Separate indications concerning deposited microorganisms and/or other biological material ............................................................................................................. 97
9.1.5.7 Sequence listing submitted for international search only (physical medium) ......... 97
9.1.5.8 Statement confirming that the information in the “Annex C/ST 25 text format” submitted under Rule 13ter is identical to the sequence listing as submitted in the international application” ................................................................. 98
9.1.5.9 Translation of international application into ......................................................... 98
9.1.5.10 OTHER (specify) (multiple instance) ................................................................. 98

10. FEES........................................................................................................................................ 99
10.1 FEES (FEE CALCULATION) ............................................................................................. 99
10.1.1 Currency (pull-down menu) ....................................................................................... 99
10.1.2 Fee schedule (pull-down menu) ................................................................................ 100
10.1.3 Updating fee schedule ............................................................................................. 100
10.1.4 Fee Calculation Table ............................................................................................... 101
10.1.4.1 Transmittal fee ...................................................................................................... 101
10.1.4.2 Search fee ............................................................................................................ 101
10.1.4.3 International Filing fee ......................................................................................... 101
10.1.4.4 International filing fee: Supplement per sheet over 30 ........................................ 101
10.1.4.5 International filing fee: EASY filing reduction .................................................... 101
10.1.4.6 Fee for priority document .................................................................................... 102
10.1.4.7 Reduction of fees for applicants from certain States ............................................ 103
Reduction of fees for applicants from certain States ............................................................. 103

11. PAYMENT ............................................................................................................................ 105
11.1.1 In addition, indicate current account authorization (check-box) .............................. 106
11.1.2 Payment at RO/IB ........................................................................................................ 106

12. ANNOTATE .......................................................................................................................... 107
12.1.1 Remarks .................................................................................................................... 108
12.1.2 Private remarks ........................................................................................................ 108
12.1.3 Inventor for certain designated States only ............................................................. 108
12.1.4 Signature of Applicant or Agent ................................................................................ 109

13. PREPARATION FOR SUBMISSION .................................................................................. 111
13.1 READY TO SUBMIT ......................................................................................................... 111
13.1.1 Copying an application file to diskette ..................................................................... 111
13.1.2 Viewing an application in the Ready to submit folder ............................................ 111
13.1.3 Correcting an error or omission in an application ready for submission .............. 112
13.1.4 Deleting forms from the Ready to submit folder ...................................................... 112
13.2 PREPARATION FOR SUBMISSION ............................................................................... 112
13.2.1 Starting the Preparation for Submission process ..................................................... 112
13.2.2 Confirmation .............................................................................................................. 113
13.2.3 Submission Log ....................................................................................................... 115
13.2.6 Creating and Copying the Zip File to Diskette ........................................................ 119
13.2.6.1 Correcting an error or omission from an application that has already been prepared for submission (but not transmitted to the Receiving Office) ................................................................. 119
13.2.7 Submitted Forms ..................................................................................................... 120
13.2.7.1 Viewing an application in the Submitted folder .................................................. 120
13.2.7.2 Printing duplicates of the forms printed during submission .............................. 120
13.2.7.3 Resending to diskette.................................................................................................................. 121
13.2.7.4 Adding International Application Number and International Filing Date to a submitted application ........................................................................................................................................ 121
13.2.7.5 Deleting files from the Submitted folder ................................................................................. 121
13.2.7.6 Declarations and power of attorney prepared after submission .............................................. 121
13.3 USEFUL LINKS............................................................................................................................................... 121
1. INTRODUCTION TO PCT-SAFE

1.1 GENERAL INFORMATION

1.1.1 The purpose of this User Reference Manual

This User Reference Manual (hereafter referred to as Manual) is intended to facilitate the use of PCT-SAFE by presenting step-by-step instructions of its functionality in PCT-EASY mode. It has been written assuming that the user has a basic understanding of how to use Microsoft Windows®. For detailed general information on filing a PCT international application, see the PCT Applicant's Guide (http://www.wipo.int/pct/guide/en/index.html), a publication of WIPO. This Manual is based on the requirements of the Patent Cooperation Treaty (PCT), the Regulations and the Administrative Instructions under the PCT. In case of any discrepancy between this Manual and those requirements, the latter are applicable.

1.1.2 PCT references

In this Manual, “Article,” “Rule” and “Section” refer to the provisions of the PCT, the PCT Regulations and the PCT Administrative Instructions, respectively. “Paris Convention” refers to the Paris Convention for the Protection of Industrial Property.

1.1.3 Updating PCT-SAFE software

The PCT-SAFE software is updated, as required, using an executable file, which modifies the software to reflect, for example, new functionality, new fee amounts, other PCT changes etc. If you would like to be notified of updates by e-mail, please subscribe to PCT e-Services notifications at http://www.wipo.int/pct-safe/en/index.html. It is also recommended to periodically check the PCT-SAFE website (www.wipo.int/pct-safe) for updates and other news.

1.2 WHAT IS PCT-SAFE?

PCT-SAFE (Secure Applications Filed Electronically) is a software designed to facilitate the preparation of PCT Request forms and applications in electronic form and to submit such applications electronically.

The PCT-SAFE software includes PCT-EASY mode, which provides the following functionality:

- a Request form module for the input and validation of data typically included in the PCT Request form and the attachment of the abstract in electronic form;
- printout of a PCT-EASY Request form, replacing the standard PCT/RO/101 form; and
- generating a .zip file with Request form data file and abstract to be submitted on a physical medium (e.g. diskette) with the entire paper application; and
- template functionality and an electronic Address Book, both of which facilitate data entry in the Request form module.

For preparing and submitting applications in fully electronic mode, please see the separate user guide.
1.2.1 Equipment needed
In order to run the PCT-SAFE software, users will need the following hardware:

- Computer processor 600MHz, or higher
- CD-ROM drive (for CD installation)
- 256 Mb of RAM
- 1 Gb of available hard disk space
- Microsoft Windows® NT, XP or Windows 7
- Adobe Acrobat or Acrobat Reader (from version 7.x recommended)
- Inkjet or laser printer
- blank formatted diskettes (3 1/2 inch) and diskette drive or possibility to copy Request form data and abstract to other physical medium (depending on the receiving Office selected)

Note: This manual generally refers to PCT-EASY “diskette” although PCT-EASY requests may also be submitted on other physical medium specified by the receiving Office (see Section 102bis of the Administrative Instructions under the PCT) and Annex C of the PCT Applicant’s Guide http://www.wipo.int/pct/en/appguide/index.jsp.

1.3 CONTACT US
For further assistance or information on PCT-SAFE, please contact the PCT e-Services Help Desk at the following address:

PCT e-Services Help Desk
World Intellectual Property Organization
34, chemin des Colombettes
CH-1211 Geneva 20
Switzerland
tel: (+41 22) 338 95 23
e-mail: ePCT@wipo.int
internet: www.wipo.int/pct-safe

When contacting the Help Desk, please indicate the Receiving Office selected for your filing and the version of the PCT-SAFE Client in your message (PCT-SAFE File Manager -> menu Tools -> settings), in order to receive promptly as accurate advice as possible.

PLEASE DO NOT SUBMIT ANY APPLICATIONS TO THE PCT e-SERVICES HELP DESK!
1.4 INSTALLING/UNINSTALLING PCT-SAFE


1.5 SPECIAL PROVISIONS FOR FILING PCT-SAFE APPLICATIONS

**IMPORTANT:** Please read these special provisions carefully before using PCT-SAFE to prepare and file PCT international patent applications.

1.5.1 Creating a PCT International Patent Application

1.5.1.1 Request, Description, Claims, Abstract, Drawings

The PCT-EASY mode of the software allows you to create a validated PCT-EASY Request form, to print it and to save it to diskette (or another physical medium, see PCT AI Section 102bis). The Request form print-out has to be signed in ink and sent to the receiving Office with the other application documents (description, claims, abstract, drawings, etc.) on paper and the PCT-EASY diskette (or other physical medium). If permitted by the receiving Office, you may submit the application by facsimile to secure the international filing date, with the original documents and diskette submitted by mail as a confirmation copy. The PCT-SAFE software helps you to furnish an error free, validated PCT Request form. The process is regulated by Section 102bis of the Administrative Instructions under the PCT.

1.5.1.2 Language

PCT-SAFE is available for preparing PCT applications in English, French, German, Japanese, Russian, Spanish, Portuguese, Chinese and Korean. Request forms prepared using PCT-SAFE may be filed in any of those languages provided that the receiving Office with which the international application is filed accepts that language for the filing of international applications (Rule 12.1(c)).

1.5.2 Filing a PCT International Patent Application

1.5.2.1 Where to file?

International applications that contain Request forms prepared in PCT-EASY Mode may only be filed with receiving Offices which are prepared to accept such filings. The list of receiving Offices and Authorities who have notified the International Bureau that they are prepared to receive and process international applications in PCT-EASY Mode can be found at the following address: http://www.wipo.int/pct-safe/en/support/easy_ro.htm. Please also see Annex C of the PCT Applicant’s Guide at http://www.wipo.int/pct/en/appguide/index.jsp.

Do not file PCT-EASY applications with a receiving Office without first verifying that the Office accepts such filings. If in doubt, contact the PCT e-Services Help Desk or the receiving Office concerned.
1.6 PCT-SAFE — OVERVIEW
PCT-SAFE software leads the user through a system of steps for the creation, management and submission of PCT-SAFE applications. Its main features are the PCT-SAFE File Manager (FM) and the PCT-SAFE Electronic Request form module.

1.7 DEMO / PRODUCTION MODE
The ‘demo’ mode of the PCT-SAFE client should only be used for training and practice filings and real filings should be prepared in ‘production’ mode. Please note that Request forms created in one mode will not be available in the other mode.

Note: Applications created in one mode can be easily moved to the other mode by using the form Export/Import functionality available via the File menu of the File Manager.

1.8 STARTING PCT-SAFE
Once PCT-SAFE is installed, click on the PCT-SAFE-FM shortcut in your Windows Start menu (Start->Programs->PCT-SAFE) to start the software.

1.8.1 PCT-SAFE File Manager folders
The PCT-SAFE File Manager is the organizing center of the PCT-SAFE system. You can access all PCT-SAFE functions from it. It consists of the following folders:

- **Templates**: Where new Request forms are ready to be filled in. The PCT/RO/101 (Normal) template corresponds to a blank form PCT/RO/101.
- **Inbox**: Where receiving Offices access and process PCT-SAFE applications in PCT-EASY mode.
- **Drafts**: Contains forms in preparation. It is good practice when working with computer applications to save your work regularly. The Drafts folder displays the following information about the forms: Template, Reference, Applicant, Last Saved and Mode.
- **Ready to sign**: Contains fully electronic applications with the mandatory information completed, awaiting signature. Not relevant in PCT-EASY mode.
**Ready to submit**  
The submission process is initiated from the File Manager. After printing the Request form, it is placed in the Ready to submit folder and ready to be saved to diskette for submission. Highlight the application, right-click and select “Submit” to save to diskette or to another location for the purposes of copying to different physical medium. If you need to make any changes to the Request form at this stage, right-click the application and select the option “Return to drafts”.

**Submitted**  
Displays all the Request forms and applications that have already been submitted.

**All documents**  
Displays all forms and applications in the File Manager, indicating where each one is stored.

---

**Note:** It is possible to switch between PCT-EASY mode and fully electronic mode as necessary. Your national receiving Office, for example, may only accept PCT-EASY type applications, or it may not be possible to file an on-line application due to unavailability of the Internet connection. In such cases you can file a PCT-EASY application, possibly faxing it to the receiving Office to secure the international filing date.

For other applications you may select fully electronic mode, e.g. when filing with WIPO’s receiving Office RO/IB ([http://www.wipo.int/pct/en/filing/filing.htm](http://www.wipo.int/pct/en/filing/filing.htm)), attach all application documents in electronic form and transmit the entire application on-line (please note that this requires a digital certificate, for further information please visit [http://www.wipo.int/pct-safe/en/certificates.htm](http://www.wipo.int/pct-safe/en/certificates.htm)).

To change the filing mode, go to the ‘Contents’ page of the electronic Request form and check the preferred radio button either “fully electronic” or “PCT-EASY”.
### The PCT-SAFE File Manager

1. **PCT-SAFE Menu Bar.** You can select commands from these menus.
2. **PCT-SAFE Folders.**
3. **PCT-SAFE Tool Bar.**
4. **View Sorting.** Depending on the attribute selected, applications can be viewed in a different format in the Information Viewer.
5. **Information Viewer.** The heart of the PCT-SAFE file manager where specific PCT-SAFE files can be viewed and accessed.

#### 1.8.2 The File Menu

Through the **File Menu** the following commands can be accessed:

1. **1.8.2.1 New Form->PCT Form**
   Select this option to open a new Request form.

2. **1.8.2.2 Export Forms or Address Book**
   **File ->Export -> Address Book/Forms**
   Select this option to back up forms or the Address Book to a location outside the PCT-SAFE folder or for data sharing purposes. The exported forms have the file extension EZF; the Address Book has a CSV extension.
When selecting the Export Forms command, the ‘Forms export’ window appears. By checking the corresponding box(es), you can select to export all forms (‘PCT-SAFE’ checkbox), or only the forms of certain folders (Templates, Drafts etc...). Then click on “Ok” for the “Save as” dialog box to appear and to enter the target location.

**Important:** As a safeguard against losing data or applications, please use the Export/Import functionality to save applications outside the PCT-SAFE folder before installing a new version of the software or up-date.

1.8.2.3 *Import Address Book or Forms*

File -> Import -> Address Book/Forms/XML from file/XML from folder

Use this option to import forms or an Address Book into PCT-SAFE. Only .EZF files can be imported.

Import XML from file or folder: this option is used to import an XML file (or .zip) like a Request form into PCT-SAFE.

1.8.3 *The Edit Menu*

Edit -> Delete

To delete an application, highlight the Request form you wish to delete and select “Delete” from the Edit menu.

1.8.4 *The Go Menu*

Go -> PCT procedure

This menu gives access to all the folders: Templates, Drafts, Inbox, Ready to submit, Submitted and All documents.

1.8.5 *The Tools Menu*

Tools -> Address Book / Maintenance / Fees / settings

To open the Address Book and to review or modify the settings of the PCT-SAFE File Manager.
1.8.6 The Help Menu

The Help menu covers all the topics of the PCT-SAFE File Manager Forms and functionalities.

A Help menu is also available at the top of the window of the Request form where all sections of the form are detailed and indexed.
Request Form Help menu

1.8.7 PCT-SAFE File Manager Settings (Menu Tools -> settings)

The PCT-SAFE settings can be accessed through the 'Tools' menu and include:
1.8.7.1 User management enabled: “you do not have the appropriate rights to perform this operation”

When opening the PCT-SAFE File Manager after installation, the ‘User management enabled’ button may be checked on the PCT-SAFE FM tab, preventing the user from accessing any Request forms (error message: “You do not have appropriate rights to perform this operation”). To disable this functionality uncheck the box ‘User management enabled’ and restart the PCT-SAFE File Manager.

1.8.7.2 PCT-SAFE FM General (not applicable in PCT-EASY mode)

1.8.7.3 Setting options

- “Address preferences” checkboxes: “City followed by postal code” or “Postal code followed by city”.
- The “Startup language” is the language of the user interface and of the Request form and it can be different from the language of filing of the application. The languages available are: English, German, French, Spanish, Portuguese, Japanese, Chinese, Russian and Korean. Select from the pull-down menu the preferred language.
- Other settings:
  “Fee amounts include digits after decimal point” : when this checkbox is checked the fee amounts indicated in the ‘Fees’ page of the Request form show the digits after the decimal point (decimals are hidden by default).

1.8.7.4 Live Update settings

- “Enable software update system”: when this box is checked PCT-SAFE will check for updates on the website.
- “Check for update every…” : indicates the number of days between each check for updates, i.e., input “30” in that field if you want the software to look for updates every 30 days.

This section also indicates the Live Update server URL where updates are downloaded and a “check now” button is available to check at any time if updates are available.
PCT-SAFE User Reference Manual - PCT-EASY Mode

PCT-SAFE FM : Live Update

![Image of PCT-SAFE File Manager: Options - Setting]

1.8.7.5 PCT filing

By pressing this button the following options can be accessed:

- "Version": indicates the version of the PCT-SAFE Client
- 'Installed on': indicates the date and time of installation
- 'Maintenance/Fee update': indicates the date of the "Maintenance/fee" schedule in the current installation
- 'FOP Version': indicates the FOP Version
- "Installation for": the default setting is "Applicant/Agent"
- If PCT-EASY is your regular filing mode, select that radio button and indicate the default destination folder where the zip file be saved
1.9 CREATING A NEW REQUEST FORM

![Diagram of PCT-SAFE File Manager with New Form and New Application windows open]
1.9 CREATING A NEW REQUEST FORM
To create a new PCT/RO/101 Request form select “File”->“New Form”->“PCT Form” sub-item in the main menu, or double click on the template “Normal” in the “Templates” folder. This will open the “New Application” dialogue box where the following information is added:

- Indicate the language of filing of the International application.
- Indicate the Agent’s or Applicant’s File Reference in the field provided. For the purposes of identifying and managing the international applications in PCT-SAFE, a unique file reference of your choice is mandatory. The file reference cannot exceed 12 characters and may be composed of either letters of the Latin alphabet and/or Arabic numerals and the - sign. It will be shown on the caption of all Request form pages after entry.
- Check the box “Use PCT-SAFE File Manager categories” if you wish to assign key words used for sorting the application in the PCT-SAFE File Manager. (See below for more information.)
- Click on “OK” to open the PCT-SAFE electronic Request form or on “Cancel” to return to the PCT-SAFE File Manager. (See the PCT-SAFE Electronic Request chapter of this Manual for information on its use.)

1.9.1 What are categories? (Optional)
Categories are key words that you assign to PCT-SAFE applications so that after saving they are easier to find and to sort within the PCT-SAFE File Manager. For example, you may wish to create categories to identify the agent or clerk responsible for a given application, and/or categories relating to subject matter.
1.9.2 Accessing categories functionality

Open a new application from the Templates folder and check the box “Use PCT-SAFE File Manager categories” from the “New Application” window.

1.9.3 Creating/assigning categories

A category can be created by opening a new application from the Templates folder, selecting the “Master Category List” button at the bottom of the ‘New application’ window, typing the name of the category in the “New Category” text box, and then selecting the “Add” button.

Categories may be associated to an application by either:

1. Entering the name for the new category in the “Create new category” edit field and by clicking on the Add button or
2. Checking the boxes from the “Existing Categories” list box, after which selected categories appear in the “Create new category” edit field.

1.9.4 Disassociating/deleting categories

A Category can be disassociated from a saved application by deselecting its check-box from the “Existing Categories” list box. A category can be deleted by selecting the “Master Category List” button, highlighting the category you wish to delete, and then selecting the “Delete” button.
1.9.5 Opening Drafts of PCT forms

Request forms that have been previously saved (but not prepared for submission) can be accessed from the Drafts folder. Double-click the desired application on the Information Viewer.

Draft forms may be listed by file name (Normal), by application content (By Document) or by category (By Category).

1.9.5.1 Deleting draft forms

Highlight the desired application on the Information Viewer, right-click and select “Delete”.
1.9.6 Creating and Using Templates (Optional)

Similarly to functionality found in popular word processing programs, PCT-SAFE has the capability of generating templates from saved PCT-SAFE application data. Any request form in the “Drafts”, “Ready to submit”, “Submitted” or “All documents” folder can be used to generate a template. This feature can greatly facilitate data entry if you need to input similar data for several applications. Templates can contain as much or as little data as you are likely to reuse. For example a template could contain agent or applicant information, payment information, etc. so as to avoid repeat entry when creating a new application.

To create a template: locate the Request form you wish to use as the basis for the template in the File Manager. Right-click, select “Save as template”. A dialog message will ask you to give the new template a unique file name of your choice. This partially filled-in request form template will then be available in the “Templates” folder.
You can also generate templates from within the Request form by creating a new Request form, adding the data to be included in the template and then selecting the "Save as Template" command from the File menu.

**To use a template:** simply select the desired template file instead of “Normal” blank form from the “Templates” folder when creating a new Request form.

**Note:** Indications made on the Contents page are not saved with templates.
1.9.7 Address book

The Address book window in PCT-EASY Mode allows you to input contact information for individuals or legal entities. The window is divided into two parts:

1. **Address 1**:
   - **Name**: JONES
   - **Address**: 1603 South East Street
   - **City**: Arlington
   - **Postal code**: 22202
   - **Country or territory**: US
   - **Region**: United States of America
   - **District**: VA
   - **Telephone**: 703-545-1228
   - **Fax**: 703-545-1229
   - **e-mail**: may.jones@email.com

2. **Address 2**: None

The categories section allows you to categorize the contact information.

Categories... [none]
1.9.7 Address book

The Address book allows you to import, export and input names and addresses for use in Request forms. Display the contents of the address book by selecting the Address book icon from the PCT-SAFE File Manager.

1.9.7.1 Adding an address to the Address book

Addresses may be added directly to the Address book or from the Names page of a PCT-SAFE Request form.

- Adding an address directly to the Address book

Click on the “Add” button on the Address book folder information viewer. The Address book entry screen opens with the Address tab selected. The following tabs are available to fill in:

- States. Information about nationality and country of residence.
- Address. Name and address details.
- Tel/e-mail. Telephone, fax and e-mail information.
- Registration. Information about Route, Role and Registration number.

- Adding an address from the Names page

Add an entry to the Names page of a Request form. Select the Address Book button below the Names Master Table, highlight the entry to be copied and then select the “Copy to Address Book” button.
### Address book

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Route</th>
<th>Role</th>
<th>Registration No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>WALSH AND COMP.</td>
<td>Legal</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CRUZ, Jose</td>
<td>Natural</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JONES, Mary</td>
<td>Natural</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RUDD, David</td>
<td>Natural</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SILVER, James</td>
<td>Natural</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SMITH, John</td>
<td>Natural</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

[Image of address book interface]
1.9.7.2 Viewing Address book contents

Using the View Sorting pull-down menu, contents can be viewed according to:

- Normal by name
- By Categories by categories assigned to Address book entries (if any)

1.9.7.3 Importing entries to the Names page

It is possible to import contacts from the Address book to the PCT-SAFE Request form Names page as follows:

Import an address directly to the PCT-SAFE Names page:

1. Open the PCT-SAFE Request form at the Names page.
2. Click on the Address book button at the bottom of the page.
3. Highlight the Address book entry to be copied to Names page.
4. Select the button for the type of entry (Applicant, Applicant/Inventor, Inventor, Agent).
5. Click the OK button.
6. Add or modify indications as needed directly on the Names details page.
2. PCT-SAFE ELECTRONIC REQUEST

2.1 PCT-SAFE ELECTRONIC REQUEST FORM
2.1 PCT/RO/101 ELECTRONIC REQUEST FORM

The PCT-SAFE Electronic Request form consists of ten pages, as follows:

- **Request**
  (See Chapter 3)
  For the indication of the receiving Office, the International Searching Authority, the language of filing of the international application, the title of the invention, and earlier search (if applicable).

- **States**
  (See Chapter 4)
  Upon filing a request, the applicant will obtain an automatic and all-inclusive coverage of all designations available under the PCT on the international filing date, in respect of every kind of protection available and, where applicable, in respect of both regional and national patents. It is possible to irrevocably exclude the designations of DE Germany, JP Japan, KR Korea. It is also possible to give details related to certain types of protection.

- **Names**
  (See Chapter 5)
  For the input of information pertaining to applicants and inventors, as well as for the input of information pertaining to agents, a common representative, or a special address for correspondence.

- **Priority**
  (See Chapter 6)
  If the priority of an earlier application is claimed, the details of such earlier application are input here, as well as the request for the receiving Office to prepare and transmit a copy of a priority document to the International Bureau (where applicable), request for the International Bureau to retrieve priority documents from the Priority Document Access Service DAS and the request for the receiving Office to restore the right of priority (where applicable).

- **Biology**
  (See Chapter 7)
  For indications with regard to deposited microorganisms or other biological material which will generate form PCT/RO/134 as part of the submission process. Where applicable, it is also necessary to indicate on this page that the international application contains a nucleotide and/or amino acid sequence listing.

- **Declarations**
  (See Chapter 8)
  For preparing one or more Declarations, using the prescribed standardized wording.

- **Contents**
  (See Chapter 9)
  For the input of details concerning the number of sheets of the request, description, claims, abstract, drawings (including the figure to be published with the abstract) and sequence listing part of the description. Any accompanying items (e.g., power of attorney, nucleotide/amino acid sequence listing (diskette)) may also be indicated here.

- **Fees**
  (See Chapter 10)
  For the input and calculation of PCT filing fees. Details concerning the currency of payment and the amounts of fees are indicated here and the total amount is automatically calculated.

- **Payment**
  (See Chapter 11)
  For the indication of the method of payment of fees chosen by the applicant (e.g., authorization to charge current account, ePayment for credit card payment etc.).

- **Annotate**
  (See Chapter 12)
  For the input of details concerning the signature of the applicant or agent and any further information which cannot be accommodated on any other page, i.e. “Remark” corresponds to the supplemental page of the standard PCT/RO/101 form. Also for viewing the Validation log.
Request form pages can be accessed by clicking on the tabs or by selecting the name of the page from the View menu.

The data entry screens will be described in the order in which they are presented in PCT-SAFE. Users may input screen information in any order, but to take full advantage of PCT-SAFE validation functionality, it is recommended to input data in the order that the screens are presented. Further information on any given screen or field is available by accessing the Help menu.

2.1.1 Speed Buttons (icons)
At the top left corner of each Request form screen is a set of functional Speed Buttons for the user’s convenience. They include:

1. Preview - the user can see a print preview, and subsequently print a Request form.
2. Print - for printing a Request form.
3. Sign - not applicable in PCT-EASY mode (used in fully electronic mode).
4. Save as Ready for Submission - once all mandatory international application data has been entered, this process may be carried out (see Chapter 13).
5. Help - opens the PCT-SAFE Help.
6. Validation - activates (and deactivates) the Validation message viewer (see validation section of this Chapter).

2.1.2 Previewing and Printing Draft and Duplicate Forms

The “Original for Submission” forms are printed as part of the Submission Process (see Chapter 13.)

2.1.2.1 Preview function
You can preview the Electronic Request form in PDF format by selecting the Preview Speed button or the Preview command from the File menu.

2.1.2.2 Print function
Select the Print speed button or Print command from the File menu to print a draft of the Request form.

Note: If the Request form to be printed has not yet been prepared for submission, pages will be identified with the header “Paper copy (NOT for submission)”. Such printouts are intended for applicant use only and should not be submitted.
2.2 VALIDATION FUNCTION

Validation is a PCT-SAFE feature which allows the user to check and confirm that indications made on the Request form pages are consistent and meet certain PCT requirements. The validation function works with a system of “traffic lights” (red, yellow, green), warning symbols (X, !, ?, √) and explanatory text. Each page tab displays a “traffic light” which changes as data is input on that particular page and a step is made towards correct completion of the application. For each item that is missing, incomplete or inconsistent on a particular Request form page, the validation window displays the “traffic light” color together with any warning symbol and an explanatory text.

The color/symbol combinations on each page have the following meanings:

Plain red: Missing indications mandatory for according an international filing date. Filing not possible
Red with “X”: Incomplete or erroneous indications also mandatory for the international filing date or other obvious error. Filing not possible
Plain yellow: Missing indications, the omission of which could prompt further communication from the receiving Office. Filing not possible
Yellow with “!”: Incomplete or erroneous indications which could prompt further communication from the receiving Office. Filing is possible
Plain green: No indication required, but applicant should, all the same, evaluate the need to make such indications. Filing is possible
Green with “?”: A reminder questioning the need for indications or verification
Green with “√”: The indications appear to be in order. Filing is possible.

Note: All applications, in all folders, can also be previewed and printed by selecting the "By document" option from the "View" pull-down menu at the top right corner of the File Manager window. Select an application and then click the + button next to the file reference. Open any PDF file (Request, fee sheet) to view or print or to save in PDF format to be used outside PCT-SAFE.
Validation messages for the selected page or screen can be viewed either by clicking on the Validation speed button or by selecting Validation from the Tools menu. Validation messages appear in a special pop-up window (see below). A complete listing of all outstanding validation messages can be viewed from the Annotate page, “Validation Log”.

![Validation Messages/Request](image)
2.3 PCT-SAFE REQUEST FORM – MENU BAR FUNCTIONS

The PCT-SAFE Menu Bar is made up of a title bar which indicates the name of the open form and five pull-down menus: File, Edit, View, Tools and Help.

2.3.1 File (Alt-F)

The File menu gives access to the following functions: Save as Draft, Save as Template, Save as Ready for Submission, Export unpacked WAD to…, Export WAD to…, Export file package, Preview, Print, Close Form.

2.3.2 Edit (Alt-E)

The Edit menu gives access to the following functions: Undo, Cut, Copy, Paste, Remark, Private Remark.

2.3.3 View (Alt-V)

The View menu gives access to the Screen pages as an alternative to clicking on the Screen page tabs: Request, States, Names, Priority, Biology, Declarations, Contents, Fees, Payment, Annotate.

2.3.4 Tools (Alt-T)

The Tools menu gives access to the following functions: Validation.

2.3.5 Help (Alt-H)

The Help menu gives access to the following Help functions: Contents and About PCT-SAFE.

On-line Help is available for most screens and fields; several fields are self-explanatory.

2.4 PCT-SAFE MASTER TABLE FUNCTIONS

2.4.1 Modifying the order of entries on a Page Master Table

Information entered in the details pages appear as entries on the Page Master Tables in the same sequence in which they were entered. (For example, Earlier Search: the earlier search input first appears as the first row entry “1,” the second “2,” etc.)

The order of appearance of input of Master Table entries may be changed by highlighting the entry to be moved and then either right-clicking or clicking the Edit pull-down menu to select Cut and Paste functions. Repeat use of these functions until the desired position is obtained. In the Names Master table in the ‘Names’ page the order of entries can be modified also by highlighting an entry, right-clicking and selecting ‘move up’ or ‘move down’.

On the Priority page it is possible to sort the priority claims chronologically. To do so, right-click again and select “sort priority claims chronologically”.

2.4.2 Deleting an entry on a Page Master Table

In order to delete an entry on a Master Table, select the entry to be deleted and then right-click and select “Cut”.

3. REQUEST

3.1 REQUEST
3.1 REQUEST

The Request consists of the following information:

3.1.1 Receiving Office

The receiving Office must be selected from the pull-down menu.

The international application (request, description, claims, abstract, drawings (if any) must be filed with a competent receiving Office (Article 11(1)(i))—that is, subject to any applicable prescriptions concerning national security, at the choice of the applicant, either:

(i) The receiving Office of, or acting for, a PCT Contracting State of which the applicant or, if there are two or more applicants, at least one of them, is a resident or national (Rule 19.1(a)(i) or (ii)), or
(ii) The International Bureau of WIPO in Geneva, Switzerland, if the applicant or, if there are two or more applicants, at least one of the applicants is a resident or national of any PCT Contracting State (Rule 19.1(a)(iii)).

Note: The International Bureau of WIPO is the only competent receiving Office for the following PCT Contracting States: Angola, Barbados, Lao People’s Democratic Republic, Madagascar, Montenegro, Nigeria, Oman, Saint Lucia, Sao Tome and Principe, Sri Lanka and United Arab Emirates.

Request forms prepared in PCT-EASY mode may only be filed with those receiving Offices which are prepared to accept such filings (participating receiving Offices: http://www.wipo.int/pct-safe/en/support/easy_ro.htm)

Do not file PCT-EASY applications with a receiving Office without first verifying that such Office accepts such filings. If in doubt contact the PCT e-Services Help Desk or the receiving Office concerned.

3.1.2 International Searching Authority

The International Searching Authority must be selected from the pull-down menu.

If there is more than one competent International Searching Authority (ISA) for carrying out the international search in relation to the international application—depending on the receiving Office with which it is filed—the competent Authority must be selected from the pull-down menu (Rules 4.1(b)(vi) and 4.14bis).

3.1.3 Language of filing of the international application

Where the receiving Office selected allows the applicant to choose between two or more filing languages, the language of filing of the international application (which may be different from the language in which the Request form is prepared) must be selected from the pull-down menu (Rule 12.1).

If the language in which the international application is filed is not accepted by the International Searching Authority selected to carry out the international search, the applicant will have to furnish a translation into a language which is all of the following: (a) a language accepted by that Authority and (b) a language of publication and (c) a language which is accepted by the receiving Office, unless the international application is filed in a language of publication. This translation must be furnished within one month from the date of receipt of the international application by the receiving Office (Rule 12.3).
3.1.4 Title of invention

The title must be short (preferably two to seven words when in English or translated into English) and precise. To facilitate the technical preparations for international publication it should be preferably entered in capital letters in the field provided and must be identical to the title heading the description (Rules 4.3 and 5.1(a)).

3.1.5 Request to use results of earlier search

The earlier search(es), if any, must be identified in such a manner that the ISA can retrieve the results easily. Where those results can be used, the ISA may refund the international search fee or a portion thereof (Rules 4.11 and 41.1).

Check the “Request to use results of earlier search” checkbox on the Request page and double-click the “Open to add reference to earlier search” row or select this row and click on the “Open” button to add details concerning an earlier search.
3.1.6 Details of Earlier Search

The applicant may request the ISA to take into account, in carrying out the international search, the results of an earlier search carried out either by that Authority, by another ISA or by a national Office (Rule 4.12). Where the applicant has made such a request and complied with the requirements under Rule 12bis, the ISA shall, to the extent possible, take into account the results of the earlier search. If, on the other hand, the earlier search was carried out by another ISA or by another national or regional Office, the ISA may, but is not obliged to, take the results of the earlier search into account (Rule 41.1).
Where the ISA takes into account the results of an earlier search, it shall (partially) refund the search fee to the extent and under the conditions provided for in the agreement under Article 16(3)(b) (see, for each ISA, the PCT Applicant’s Guide, Annex D at http://www.wipo.int/pct/guide/en/index.html).

Any request to take into account the results of an earlier search should identify the filing date and number of the application in respect of which the earlier search was carried out and the Authority or Office which carried out the earlier search (Rules 4.1(b)(ii) and 4.12(i)).

This screen is composed of the following fields:

3.1.6.1 Country (or regional Office) (pull-down menu)
Select from the pull-down menu the country (or regional Office) where the earlier search was filed.

**Note:** This menu defaults to the International Searching Authority indicated by the user and lists other options only where available.

3.1.6.2 Filing Date
Enter the date of filing of the earlier application following the prescribed date format provided. All dates will automatically be formatted to PCT standards (day, month, year).

3.1.6.3 Number
Enter the filing number of the application in respect of which the earlier search was carried out.

After entry, earlier searches appear as entries on the Earlier Search Master Table in the same sequence in which they were entered. (For example, the earlier search input first appears as the first row entry “1,” the second “2,” etc.)

For details on how to modify the order in which entries appear on the Earlier Search Master Table and how to delete entries from the Earlier Search Master Table, see Chapter 2.42.4.1 and 2.4.2.

To remove an entry from the table select the corresponding line, right-click and select option “Cut”.

4. STATES

4.1 STATES (Designations (Regional and national patents))

Upon filing of the Request, the applicant will obtain an automatic and all-inclusive coverage of all designations available under the PCT on the international filing date, in respect of every kind of protection available and, where applicable, in respect of both regional and national patents. If the applicant wishes the international application to be treated, in a certain designated or elected State, as an application not for a patent but for another kind of protection available under the national law of the designated or elected State concerned, the applicant will have to indicate his choice directly to the designated or elected Office when performing the acts, referred to in Articles 22 or 39(1), for entry into the national phase. For details about various kinds of protection available in designated or elected States, see the PCT Applicant's Guide, Annexes B1 and B2 at http://www.wipo.int/pct/guide/en/index.html.

However, for the reasons explained below, it is possible to indicate, by marking the applicable check-box(es), that DE Germany, JP Japan and KR Republic of Korea are not designated for any kind of national protection. Each of those States has notified the International Bureau that Rule 4.9(b) applies to it since its national law provides that the filing of an international application which contains the designation of that State and claims the priority, at the time of filing or subsequently under Rule 26bis.1 of an earlier national application (for DE: for the same kind of protection) having effect in that State shall have the result that the earlier national application ceases, where applicable, after the expiration of certain time limits, to have effect with the same consequences as the withdrawal of the
earlier national application. The designation of DE Germany for the purposes of an EP European patent is not affected by what is said above. For details see the PCT Applicant's Guide, in the relevant Annex B1.

Only the three States mentioned above may be excluded from the all-inclusive coverage of all designations in Box No. V. For any other PCT Contracting State which the applicant wishes to exclude from the all-inclusive coverage of all designations, the applicant should submit a separate notice of withdrawal of the designation concerned under Rule 90bis.2.

Important: Should a notice of withdrawal be filed, that notice will have to be signed by the applicant or, if there are two or more applicants, by all of them (Rule 90bis.5(a)), or by an agent or a common representative whose appointment has been effected by each applicant signing, at his choice, the request or a separate power of attorney (Rule 90.4(a)).
4.1.1 Reference to parent application or grant details page

Reference to "continuation" or "continuation-in-part", or parent application or grant (Rules 4.11(a)(iii) or(iv) and 49bis.1(c) or (d)).

If the applicant intends to request that the international application be treated, in certain designated States, as an application for a patent of addition, certificate of addition, inventor's certificate of addition or utility certificate of addition: in such a case, select (double-click) on the name or two-letter code of each designated State concerned and then select the relevant indication: “patent of addition,” “certificate of addition”, “inventor's certificate of addition” or “utility certificate of addition”, enter the number of the parent application or parent patent or other parent grant and the date of grant or the date of filing of the parent application (Rules 4.11(a)(iii) and 49bis.1(a) or (b)).

If the applicant intends to request that the international application be treated, in the United States of America, as a continuation or continuation-in-part of an earlier application: in such a case, select (double click) "United States of America" or "US" and the indication “continuation” or “continuation-in-part” and enter the number and the filing date of the parent application (Rules 4.11(a)(iv) and 49bis.1(d)) as shown below.
4.1.2 OAPI Patent (OA)

Where the applicant wishes to designate OAPI for a title of protection other than a patent (e.g., certificate of addition), select it from the “Kind of parent application or grant” pull-down menu, also indicate the number of the parent title or parent application, and the date of grant of the parent title or the date of filing of the parent application in the fields provided.
5. NAMES

5.1 NAMES (Applicant, Inventor, Agent, Common Representative)
5.1 NAMES (APPLICANT, INVENTOR, AGENT, COMMON REPRESENTATIVE)

The Names page is for the input of information pertaining to applicants, applicant/inventors and inventors, as well as for the input of information pertaining to agents, a common representative, or a special address for correspondence.

It consists of the:

- Names Master Table,
- the Address Book button
- the Power of Attorney button

5.1.1 Names Master Table

The Names Master Table consists of five input functions:

- Add Applicant (to indicate an applicant or applicant/inventor)
- Add Inventor only (to indicate an inventor only)
- Add Agent (to indicate an agent)
- Add Common Representative (to select one of the applicants as common representative)
- Add Special Address for Correspondence (in the absence of either an agent or a common representative, to indicate a special address to which correspondence should be sent). The correspondence Address and Common Representative tabs will only appear when no Agent has been entered.

After entry, applicants, inventors and agents appear as entries on the Names Master Table in the same sequence they are entered. (For example, the applicant whose name has been input first becomes “1. Applicant,” the second “2. Applicant,” etc.)

The order of entries may be changed by highlighting the entry to be moved, right-clicking and then selecting “Move up” or “Move down”. Repeat use of these functions until the desired position is obtained.

In order to delete a name, select the entry to be deleted, right-click and select “Cut”.

5.1.2 Using the Address book

The name and address of applicants, inventors and agents may be stored in the Address book. For details on how to use the Address book see Chapter 1.9.7
5.1.3 Add Applicant (add applicant or applicant/inventor function)

Double click the Applicant row or select this row and click on the Open button to add an applicant or applicant/inventor. This screen is composed of the following fields:

5.1.3.1 Legal entity/Natural person (radio buttons)

By selecting one of these two radio buttons the user can identify whether the entry concerns a legal entity or a natural (physical) person.

5.1.3.2 Name (of legal entity)

Names of legal entities are indicated in this field (preferably in capital letters) by their full, official designations. (Rule 4.4(b))

5.1.3.3 Name (of natural person)

The family name is indicated in the corresponding field (preferably in capital letters). The first name must be indicated in the corresponding field. Titles and academic degrees must be omitted.

5.1.3.4 This person is also inventor (check-box)

Check this box if the applicant is both applicant and inventor. This box cannot be checked if the applicant is a legal entity. Where the United States of America is one of the designated States, all of the inventors must be named as applicants for the United States of America and the check-box “This person is also inventor” must be checked.

To indicate an inventor who is not also applicant, use the “Add Inventor only” function (see the Add Inventor Only section of this chapter).
5.1.3.5 Country or territory

The pull-down list consists of two fields.

In the first field, the user can simply input the two-letter country code for the desired country or territory of the address, after which, the full name of the country or territory is then automatically defaulted into the second field. Alternatively, the user may select the full name of the country or territory in the second field, after which the relevant code for that country or territory is automatically defaulted in the first field.

5.1.3.6 Address

First address field

This optional indication can, in the case of a legal entity, be used to identify a contact person, department, etc. For a natural person it can be used to indicate c/o details or company name.

Second address field

The street address is entered here. The address must be indicated in such a way that it allows prompt postal delivery; it must consist of all the relevant administrative units (up to and including the indication of the house number, if any). (Rule 4.4(c))

Only one address may be indicated per person (Rule 4.4(d)). For the indication of a special “address for correspondence,” see the Add Special Address for Correspondence section of this chapter.

5.1.3.7 City

Complete this field with the full city name.

5.1.3.8 State/County/Province

This field only appears if applicable. Select the State, Province, County, from the list.

5.1.3.9 Postal code

The address must contain the postal code or zip code (if any).

5.1.3.10 Telephone

Should be indicated to allow rapid communication with the applicant or agent. Any such number should include the applicable country and area codes.

5.1.3.11 Facsimile

Should be indicated to allow rapid communication with the applicant or agent. Any such number should include the applicable country and area codes.

5.1.3.12 E-mail

Unless one of the applicable check-boxes is selected, any e-mail address supplied will be used only for the types of communication which might be made by telephone. If one of the applicable check-boxes is marked, the receiving Office, the International Searching Authority, the International Bureau and the International Preliminary Examining Authority may send notifications in respect of the international application to the applicant, avoiding processing or postal delays. Note that not all Offices will send such notifications by e-mail, (for details about each Office’s procedure see the PCT Applicant’s Guide, Annex B). If the first check-box is marked, any such e-mail notification will always be followed by the official notification on paper. Only that paper copy of the notification is considered the legal copy of the notification and only the date of mailing of that paper copy will commence any time limit within the meaning of Rule 80. If the second check-box is marked, the applicant requests the discontinuation of the sending of
paper copies of notifications and acknowledges that the date of mailing indicated on the electronic copy will commence any time limit within the meaning of Rule 80. If the second check-box “exclusively in electronic form (no paper notifications will be sent)” is marked, the applicant requests the discontinuation of the sending of paper copies of notifications and acknowledges that the date of mailing indicated on the electronic copy will commence any time limit within the meaning of Rule 80.

Note that it is the applicant’s responsibility to keep any e-mail address details up-to-date and to ensure that incoming e-mails are not blocked for any reason on the recipient’s side. Changes to the e-mail address indicated in the request should be requested to be recorded, preferably directly at the International Bureau, under Rule 92bis. Where the e-mail authorization is given both in respect of the applicant and in respect of an agent or common representative, the International Bureau will send e-mail communications only to the appointed agent or common representative.

5.1.3.13 Nationality (Rules 4.5(a) and (b) and 18.1)

The Request should indicate the address, nationality and residence for each applicant. However, if there is more than one applicant and those indications have not been furnished in respect of all applicants, it will be sufficient, for the purposes of filing the international application, if those indications have been provided in respect of one of the applicants who is entitled, according to PCT Rule 19.1, to file the international application with the receiving Office (see new PCT Rule 26.2bis(b)); the RO will no longer invite the applicant to furnish such missing indications. The indication of the nationality is not required where a person is inventor only.

This indication may be input using the pull-down list, which consists of two fields. In the first field, the user can simply input the two-letter country code for the desired indication, after which, the full name of the country or territory is then automatically defaulted into the second field. Alternatively, the user may select the full name of the country or territory in the second field, after which the relevant code for that country or territory is automatically defaulted in the first field.

5.1.3.14 Residence (Rules 4.5(a) and (c) and 18.1)

Each applicant’s State (i.e., country) of residence should be indicated. However, if there is more than one applicant and those indications have not been furnished in respect of all applicants, it will be sufficient, for the purposes of filing the international application, if those indications have been provided in respect of one of the applicants who is entitled to file the international application with the receiving Office. If the State of residence is not indicated, it will be assumed to be the same as the State indicated in the address. Possession of a real and effective industrial or commercial establishment in a State is considered residence in that State. The indication of the residence is not required where a person is inventor only.

This field is automatically populated with the same data as input in the country or territory field, from the address, where possible. It may be altered manually, as required, using the pull-down list, which actually consists of two fields. In the first field, the user can simply input the two-letter country code for the desired indication, after which, the full name of the country or territory is then automatically defaulted into the second field. Alternatively, the user may skip to the second field and select the full name of the country or territory, after which the relevant code for that country or territory is automatically defaulted in the first field.
5.1.3.15 Applicant designations (This person is applicant for the purposes of:)

Select the designated States for which the person identified is to be considered applicant by clicking the appropriate radio button:

- All designated States
- Certain designated States only

**Different applicants for different designated States:**

It is possible to indicate different applicants for the purposes of different designated States. At least one of all the applicants named must be a national or resident of a PCT Contracting State for which the receiving Office acts, irrespective of the designated State(s) for the purposes of which that applicant is named (Rules 4.5(d), 18.3 and 19.2). If the international application is filed with the International Bureau under Rule 19.1(a)(iii), at least one of the applicants must be a resident or national of any PCT Contracting State.

**All designated States**

This radio button must be selected where the person identified is and qualifies as applicant for all designated States.

**Certain designated States only**

This radio button can be used to indicate different applicants for different designated States or where an applicant is indicated for some, but not all, designated States. It is possible to make such an indication using the “Select/Modify” button (appearing only when the “Certain designated States only” radio button has been selected). Selecting this button gives access to a complete list of designated States. To indicate the designated States for which a person is applicant, click to insert a checkmark (√) to the left of the State(s) concerned (as shown below).

Where a particular State has been designated for both a national patent and a regional Patent, the same applicant or applicants shall be indicated for both designations. Consequently, for the purposes of the “Certain designated States only” list, both the national and regional designation for such a State must be checked together.

For instructions on how to fill in the applicant's contact details see Chapter 5.1.3 of this manual.
5.1.4 Add Inventor Only (to indicate an inventor only)

Naming of Inventor (Rule 4.1(a)(v) and (c)(i)):

The inventor’s name and address must be indicated where the national law of at least one of the designated States requires that the name of the inventor be furnished at the time of filing; for details see Annexes B1 and B2 of the PCT Applicant’s Guide. It is strongly recommended to always name the inventor.

Note: Different persons may be indicated as inventors for different designated States (e.g., where, in this respect, the requirements of the national laws of the designated States are not the same). However, such an indication may only be made on the Annotate page by selecting the indication “Different inventors for different designated States” from the pull-down menu and by clicking on the ‘Add’ button. In the absence of any specific indication on that page, it will be assumed that the inventor(s) named is (are) inventor(s) for all designated States. (Rule 4.6(c))

Double-click the “Add Inventor only” row or select this row and click on the Open button to add an inventor only (i.e., an inventor who is not also applicant).

This screen is composed of fields also found on the Add applicant screen. Please refer to that part of the Names chapter for information on their use. It also contains the following field:
5.1.4.1 Deceased (check-box)

Select this check-box to indicate that the inventor is deceased.

If the United States of America is designated the legal representative or the heir(s) of the deceased inventor must be named as the applicant(s) for the United States of America. In such a case complete the following steps:

(1) The legal representative must be indicated as applicant for the purposes of the United States of America using the “Add Applicant or applicant/inventor” function. The residence, nationality and address of the legal representative or heir should be indicated rather than those of the deceased inventor.

(2) Subsequent to this entry, it is possible to indicate this person as successor to the rights of the deceased inventor for the purposes of the designation of the United States of America from the table appearing on the deceased inventor's details screen. Click to insert a checkmark (√) to the left of the name of the applicant concerned and select this person’s legal capacity from the pull-down menu.

Repeat steps (1) and (2) where there is more than one legal representative for the deceased inventor.
5.1.5 Add Agent (to indicate an agent)

![Add Agent window](image_url)
5.1.5 **Add Agent (to indicate an agent)**

Double click the Add Agent row or select this row and click on the Open button to add a person who is (or has been) appointed as “agent”.

This screen is composed of fields also found on the Add applicant screen. Please refer to that part of the Names chapter for information on their use. It also contains the following fields:

5.1.5.1 **Same address as the first-named agent (check-box)**

Select this check-box only if the agent identified has the same address as the first-named agent. When selected, all agent address fields are removed for this agent as shown above.

5.1.5.2 **Who can act as agent?**

For each of the receiving Offices information as to who can act as agent is given in Annex C of the PCT Applicant’s Guide. (Article 49 and Rule 83.1bis)

5.1.5.3 **Manner of appointment of agent**

Any such appointment may be made by designating the agent(s) in the Request or in one or more separate powers of attorney.

---

**Note:** Under PCT Rule 4.15 each applicant should sign the Request. If there is more than one applicant, it will be sufficient, however, for the purposes of filing the international application, if the Request is signed by one of them (see new PCT Rule 26.2bis(a)); the receiving Office (RO) will no longer invite the applicant to furnish the missing signature(s) of the other applicant(s).

However, the signature may be that of the agent where a separate power of attorney appointing the agent, or a copy of a general power of attorney already in the possession of the receiving Office, is furnished. If the power is not attached to the Request, the receiving Office may invite the applicant to furnish it subsequently, unless the Office has waived the requirement for a separate power of attorney.

Where the international application is filed with reference to a general power of attorney, a copy thereof must be attached to the Request. Any applicant who did not sign the general power of attorney must sign either the Request or a separate power of attorney. (Rules 90.4 and 90.5 and Section 106)

5.1.5.4 **Correspondence**

Where an agent is appointed, any correspondence intended for the applicant will be sent to the address indicated for that agent (or for the first-mentioned agent, if more than one is appointed). Where several agents are listed, each must be indicated individually and the agent to whom correspondence should be addressed is to be listed first. (Rule 4.4(d) and Section 108).
5.1.5.5 E-mail

See chapter 5.1.3.12.

5.1.5.6 Power of attorney

When an agent or a common representative has been indicated on the Names page, it will be possible to create a power of attorney.

1. Click on the “Power of attorney” button and select the name(s) of the applicant(s) who give the power of attorney by checking the corresponding checkboxes. In case of corporate applicant, the name and capacity of the signatory must be indicated in the corresponding fields.

2. Click "Preview" which opens up the Power of attorney in the PDF Viewer. From the Viewer window it can be printed to apply ink signatures and/or saved by clicking on the corresponding print and save icons at the top of the window.

Note: A power of attorney can also be prepared after submission of the application, directly from the “Submitted” folder: double click the Request form concerned to open it, go to the Names page and fill in the form as explained above. The form will then need to be printed, signed and sent to the Office concerned.
5.1.6 Add Common Representative (to select an applicant as a common representative)

![Image of PCT-SAFE interface showing the section for adding a common representative]
5.1.6 Add Common Representative (to select an applicant as a common representative)

Double click the "Add Common Representative" row or select this row and click on the Open button to open the "Common Representative Details" screen where one of the applicants can be indicated as "common representative". Election of a common representative by the other applicants is only possible where more than one applicant or applicant/inventor has been indicated on the Applicant screen. The "common representative" must be one of the applicants who is a national or resident of a PCT Contracting State entitled to file an international application. (Rule 90.2(a))

5.1.6.1 Name of Common Representative (pull-down menu)

Select the name of one of the applicants to indicate this person as "common representative".

**Note:** Where an applicant has been selected as common representative, the address indicated for this person as applicant is automatically copied to the common representative address fields. This address may be modified should the applicant have a different address for the purposes of his election as common representative.
5.1.6.2 Manner of appointment of Common Representative

Any such appointment may be made by designating the common representative in the Request or in one or more separate powers of attorney.

Note: Under PCT Rule 4.15 each applicant should sign the Request. If there is more than one applicant, it will be sufficient, however, for the purposes of filing the international application, if the Request is signed by at least one of them (see PCT Rule 26.2bis(a)); the receiving Office (RO) will not invite the applicant to furnish the missing signature(s) of the other applicant(s).

However, the signature may be that of the common representative where a separate power of attorney appointing the common representative, or a copy of a general power of attorney already in the possession of the receiving Office, is furnished. If the power of attorney is not filed with the application, the receiving Office may invite the applicant to furnish it subsequently, unless the Office has waived the requirement for a separate power of attorney.

Where the international application is filed with reference to a general power of attorney, a copy thereof must be filed with the application.

5.1.6.3 Correspondence

Any correspondence intended for the applicant will be sent to the address indicated for the common representative. (Rule 4.4(d) and Section 108)

If no common representative is appointed, the applicant first named in the Request who is entitled to file an international application with the receiving Office concerned will automatically be considered to be the common representative (the “deemed” common representative) (Rule 90.2(b)) and any correspondence will be sent to his address.

5.1.6.4 E-mail

See chapter 5.1.3.12.
5.1.7 Add Special Address for Correspondence
5.1.7 Add Special Address for Correspondence

Where no agent or common representative is appointed, any correspondence will be sent to the address indicated on the Names Master Table for the applicant (if only one person is named as applicant) or of the applicant who is considered to be common representative (if there are two or more persons named as applicants).

However, if correspondence is to be sent to a different address, in such a case, that address may be indicated by using the Add Special Address for Correspondence function. In this case, and only in this case, should the Add Special Address for Correspondence function be used.

This screen is composed entirely of fields also found on the Add applicant screen. Please refer to that part of the Names chapter for information on their use.
6. PRIORITY

6.1 PRIORITY (Priority claim)

6.1.1 General Information on Priority Claims

If the priority of an earlier application is claimed, the declaration containing the priority claim must be made in the Request (Rule 4.10).

The request must indicate the date on which the earlier application was filed and the number it was assigned. Note that that date must fall within the period of 12 months preceding the international filing date.

Where the earlier application is an international application, the receiving Office with which that earlier application was filed must be indicated.

Certified Copy of Earlier Application (Rule 17.1)

A certified copy of each earlier application the priority of which is claimed (priority document) must be submitted by the applicant, irrespective of whether that earlier application is a national, regional or international application. The priority document must be submitted to the receiving Office or to the International Bureau before the expiration of 16 months from the (earliest) priority date or, where an early start of the national phase is requested, not later than at the time such a request is made.
Any priority document received by the International Bureau after the expiration of the 16-month time limit but before the date of international publication shall be considered to have been received on the last day of that time limit (Rule 17.1(a)).

Where the priority document is issued by the receiving Office, the applicant may, instead of submitting the priority document, request the receiving Office (not later than 16 months after the priority date) to prepare and transmit the priority document to the International Bureau. Such request may be made by checking the applicable check-box on the Details of Priority Claim of Earlier Application screen.

The International Bureau may only retrieve priority documents from digital libraries via the WIPO Digital Access Service for Priority Documents (DAS). Applicants who have taken the necessary steps to make such documents available via DAS may request the International Bureau to obtain them by marking the applicable check-boxes on the Priority page. WIPO DAS is in a period of transition as of July 2012. If the document is retrievable by DAS, the Office where the application was filed (or the International Bureau on behalf of that Office) will have sent the applicant an access code which relates to that specific priority document. This code can either be indicated in the relevant space on the Priority page (new system) or the applicant can instead go to the DAS applicant portal http://www.wipo.int/patentscope/en/priority_documents/ on the WIPO website and ensure that Office "IB" has been given access to the document (old system, still in use for the transitional period).

Applicants who wish to make priority documents available via DAS should refer to the PCT Applicant’s Guide, Annex B of the particular DAS depositing Office for further indications of the procedure to be followed. Information concerning whether and which priority documents are available to the International Bureau from a digital library is published in the Official Notices (PCT Gazette) pursuant to Section 715(c) and the PCT Applicant’s Guide, Annex B(IB).

Information on the DAS participating Offices and other details are also available on the DAS portal at http://www.wipo.int/patentscope/en/priority_documents/.

Applicants using the DAS system will meet the time limits as long as they both request the International Bureau to obtain the priority document from a digital library and take all necessary steps to ensure that the document is accessible to the International Bureau from that library before the date of international publication (Rule 17.1(b-bis)).

6.1.2 The Priority Page

The Priority page contains a Priority Claim Master Table where the priority claims of such earlier applications can be indicated.

Double click the row “Add priority claim” or highlight it and click Open.

Selecting this row opens up the “Details of Priority Claim of Earlier Application” screen where indications concerning the priority can be made.

After entry, priority claims appear on the Priority Claim Master Table as entries in the same sequence in which they were entered. It is recommended, but not mandatory, that the earliest priority be entered first. By right-clicking it is also possible to select “sort priority claims chronologically”. To delete a priority claim, right-click and select “Cut”.
6.1.3 Details of Priority Claim of Earlier Application

The content of this screen depends upon the filing route selected:

6.1.3.1 National (radio button)
Select this radio button if the earlier application is a national application.

6.1.3.2 Regional (radio button/pull-down menu)
Select this radio button if the earlier application is a regional application.

6.1.3.3 International (PCT) (radio button)
Select this radio button if the earlier application is an international (PCT) application.

6.1.4 Details of Priority Claim of Earlier Application (National)
6.1.4 Details of Priority Claim of Earlier Application (National)

This screen is composed of the following fields when “National” has been selected from the filing route radio button group:

6.1.4.1 Country
By typing in the country code, or selecting the country from the pull-down menu, indicate the country party to the Paris Convention in which the earlier national application was filed. (Rule 4.10(a)(iii))

6.1.4.2 Filing date
The date on which the earlier application, for which priority is claimed, was filed must be entered in this field. (Rule 4.10(a)(i))

The filing date of the earlier application is entered in the format specified in the edit field.

For the purposes of the PCT Request form printout, all dates will automatically be formatted to PCT standards.

6.1.4.3 Number
The number assigned to the earlier application for which priority is claimed must be indicated in this field. (Rule 4.10(a)(ii))

6.1.4.4 Request copy of priority document from RO (check-box)
Where the priority document is issued by the receiving Office, the applicant may, instead of submitting the priority document, request the receiving Office (not later than 16 months after the (earliest) priority date) to prepare and transmit the priority document to the International Bureau. Such request may be made by checking the corresponding check-box on the “Details of Priority Claim of Earlier Application” screen for each earlier application for which the priority document is requested.

Attention: Where such a request is made, the applicant must, if applicable, pay to the receiving Office the fee for priority document, otherwise, the request will be considered not to have been made. (Rule 17.1(b))
If you wish to take advantage of the DAS system, you first have to take the necessary steps to make such a document available via DAS, i.e. request the Office of first filing (a DAS participating Office) to register it with the system.

You can then request the International Bureau to obtain such a priority document by marking the applicable check-box and indicating the access code provided by the Office which registered the document with DAS (in some cases the code is sent by the International Bureau on behalf of that Office). This code will allow DAS to release the document to the International Bureau for use as a PCT priority document.

During the transition period, until all DAS participating Offices have moved to the new system allowing the indication of the access code on the request form, the original way of using DAS will continue in parallel, i.e., indicating on the applicant portal (http://www.wipo.int/patentscope/en/priority_documents/) that the International Bureau is permitted to access the document. Applicants whose first filing was at an Office using the so-called "Route C" system for DAS (JPO, KIPO or USPTO) will, until those Offices move fully to the new system, still need to use the access code provided by the Office in the applicant portal for the stage of ensuring that the document is registered with the system, but will then be able to provide the access code to the International Bureau as described above.
6.1.4.5 Restoration of the Right of Priority (Rules 4.1(c)(v) and 26bis.3)

Where the international application is filed on a date which is later than the date on which the priority period (see Rule 2.4) expired but within the period of two months from that date, the applicant may request the receiving Office to restore the right of priority (Rule 26bis.3). Such a request must be filed with the receiving Office within two months from the date on which the priority period expired; it may be included in the Request form by identifying the priority claim(s) concerned on the ‘Details of Priority Claim of Earlier Application’ screen and by checking the corresponding checkbox. It is possible to request the restoration of the right of priority for earlier national, regional and international applications.

Where a request to restore the right of priority is made, a separate document should be submitted entitled “Statement for Restoration of the Right of Priority”. This separate document should indicate, for each earlier application concerned, the filing date, the earlier application number and the name or two-letter code of the country, Member of WTO, regional Office or receiving Office. Then, for each earlier application concerned, the applicant should state the reasons for the failure to file the international application within the priority period (Rules 26bis.3(a) and 26bis.3(b)(ii)). Note further that the receiving Office may require the furnishing, within a reasonable time limit, of a declaration or other evidence in support of the statement of reasons; preferably, such declaration or other evidence should already be submitted to the receiving Office together with the request for restoration (Rule 26bis.3(b) and (f)). The receiving Office shall restore the right of priority if it finds that a criterion for restoration applied by the Office is satisfied (Rule 26bis.3(a)).

For information on which criteria a receiving Office applies see the PCT Applicant’s Guide, Annex C.

Attention: The procedure for restoration of the right of priority is not applicable to a receiving Office which has provided notice to the International Bureau under Rule 26bis.3(j) of the incompatibility of Rule 26bis.3(a) to (i) with the national law applied by that Office.

A request for restoration of the right of priority may be subjected by the receiving Office to the payment to it of a fee, payable within the time limit referred to above (Rule 26bis.3(e)).
6.1.5 Details of Priority Claim of Earlier Application (Regional)

![Screenshot of Details of Priority Claim of Earlier Application](image)

Regional Office: EP (European Patent Office)

Filing date: 12 August 2011

Number: 11587766.0

- The International Bureau is requested to obtain from a digital library a certified copy of the above-identified earlier application.

- The receiving Office is requested to prepare and transmit to the International Bureau a certified copy of the above-identified earlier application.

- The receiving Office is requested to restore the right of priority.
6.1.5 Details of Priority Claim of Earlier Application (Regional)

This screen is composed of the following fields when “Regional” has been selected from the filing route radio button group:

6.1.5.1 Regional Office (pull-down menu)
Select the appropriate regional office from the pull-down menu to indicate the Office with which the regional application was filed. (Rule 4.10(a)(iv))

6.1.5.2 Filing date
The date on which the earlier application, for which priority is claimed, was filed must be entered in this field. (Rule 4.10(a)(ii))

The filing date of the earlier application must be entered in the format specified in the edit field.

6.1.5.3 Number
The number assigned to the earlier application for which priority is claimed must be indicated in this field.

6.1.5.4 Country party to the Paris Convention for the Protection of Industrial Property for which the earlier application was filed (ARIPO application)
Where the earlier application is an ARIPO application, at least one country party to the Paris Convention for which that earlier application was filed must be indicated (Rule 4.10(b)(i) and (ii)). By typing in the country code, or selecting the country from the pull-down menu, enter the country or one of the countries party to the Paris Convention for which the earlier ARIPO application was filed (i.e., the country or one of the countries designated for protection in the ARIPO application).

6.1.5.5 Request copy of priority document from RO (check-box)
See chapter 6.1.4.4

6.1.5.6 Restoration of the Right of Priority (Rules 4.1(c)(v) and 26bis.3)
See chapter 6.1.4.5.
6.1.6 Details of Priority Claim of Earlier Application (International (PCT))

This screen is composed of the following fields when “International (PCT)” has been selected from the filing route radio button group:

6.1.6.1 Receiving Office
By typing in the country or office code, or selecting the country or office from the pull-down menu, indicate the Office with which the international application was filed (i.e., the receiving Office). (Rule 4.10(a)(v))

6.1.6.2 Filing date
The date on which the earlier application, for which priority is claimed, was filed must be entered in this field. (Rule 4.10(a)(ii))

The filing date of the earlier application must be entered in the format specified in the edit field.

For the purposes of the PCT request form printout, all dates will automatically be formatted to PCT standards.

6.1.6.3 Number
The number assigned to the earlier application for which priority is claimed must be indicated in this field.
6.1.6.4 Request copy of priority document from RO (check-box)

See chapter 6.1.4.4

6.1.6.5 Restoration of the Right of Priority (Rules 4.1(c)(v) and 26bis.3)

See chapter 6.1.4.5.
7. BIOLOGY

7.1 BIOLOGY (Indications Relating to Deposited Microorganism and/or Other Biological Material)

Double click the “Open to add new item” row of the Biology Master Table or select this row and click the Open button to add details concerning indications relating to a deposited microorganism and/or other biological material.

Under PCT Rule 13bis.3 the applicant is required to give the following indications with regard to deposited biological material:

1. the name and address of the depositary institution with which the deposit was made;
2. the date of deposit of the biological material with that institution; and
3. the accession number given to the deposit by that institution.

Certain designated Offices require that the indications relating to the deposit of biological material must be included in the description at the time of filing so the form, if submitted when the international application is filed, may need to be included as one of the sheets of the description; otherwise the indications given in it will not be taken into account by those Offices in the national phase (see Annex L of the PCT Applicant’s Guide (http://www.wipo.int/pct/guide/en/index.html)).

To the extent that indications relating to the deposit of biological material are not given in the description, they may be furnished on Form PCT/RO/134. If this form is generated...
and submitted when the international application is filed, it will be referenced in the Accompanying Items of the Check list.

7.1.1 Details Concerning Indications Relating to a Deposited Microorganism and/or Other Biological Material

Information entered in the Biology details screen will be used to generate form PCT/RO/134.

7.1.1.1 Indications in the description

Where the indications relating to the deposit of biological material have been included in the description, the page and line numbers or the paragraph number(s) of where such indications have been made should be entered in the appropriate fields.

7.1.1.2 Depositary institution

Select the name of the depositary institution with which the biological material was deposited from the pull-down menu. The depositary institutions are listed by alphabetical order of their acronym followed by the name of the institution.

7.1.1.3 Address

The address of the depositary institution will be automatically generated when selecting the name of the depositary institution concerned from the pull-down menu.
7.1.1.4 Accession Number

The first of the two fields under the heading “Accession Number” will show the acronym of the depositary institution with which the biological material was deposited. This information will be automatically generated when selecting the name of the depositary institution concerned from the pull-down menu. Enter the accession number attributed to the deposit.

7.1.1.5 Date of deposit

Enter the date of deposit of the microorganism following the date format provided.

7.1.1.6 Additional Indications

The national laws of some designated Offices require that, besides indications concerning the deposit of biological material, an indication be given concerning the biological material itself, for example, a short description of its characteristics, at least to the extent that this information is available to the applicant. These requirements must be met, provided that the requirements have been notified to the International Bureau and published in the *PCT Gazette*. Annex L of the *PCT Applicant’s Guide* indicates, for each of the designated Offices, the requirements (if any) of this kind which have been so notified and published. (Rules 13bis.3(a)(iv) and 13bis.7(a))

If additional indications are given, enter them in the field entitled “Additional Indications”.

7.1.1.7 Separate Furnishing of Indications

If any indication is not included in a reference to deposited biological material contained in the international application as filed, it may be furnished to the International Bureau within 16 months from the priority date unless the International Bureau has been notified (and, at least two months prior to the filing of the international application) and unless has published in the *Official Notices (PCT Gazette)* that the national law requires the indication to be furnished earlier. However, if the applicant makes a request for early publication, all indications should be furnished by the time the request is made, since any designated Office may regard any indication not furnished when the request is made as not having been furnished in time. Annex L of the *PCT Applicant’s Guide* specifies, for each designated Office whose national law requires a reference to deposited biological material to be furnished earlier than 16 months after the priority date, the applicable time limit(s) for furnishing such indications. (Rules 13bis.3(b), 13bis.4 and 48.2(a)(viii)) (PCT Applicant’s guide - §482)

If indications will be made separately from the filing of the international application, enter the appropriate information in the field entitled “Separate Furnishing of Indications”.
7.1.1.8 **Designated States for Which Indications Are Made**

A reference to deposited biological material may be made for the purposes of all designated States or for one or only some of the designated States. A reference is considered to be made for the purpose of all designated States unless it is expressly made for certain designated States only. References to different deposits may be made for the purposes of different designated States. (Rule 13bis.5)

**All Designated States**

Click on the “All Designated States” button if the indications relating to a deposited microorganism apply to all designated States.

**Certain Designated States Only**

Click on the “Certain Designated States Only” button if the indications relating to deposited biological material apply to one or only some of the designated States. Click on the “select/modify” button to access a list of the States designated in the application. The designated States for which the indications relating to deposited biological material apply should be indicated by a checkmark (✓) to the left of the State’s name on the “View/Change States” details page.

7.1.1.9 **Sequence listing**

Where the international application contains disclosure of one or more nucleotide and/or amino acid sequences, it should be contained in a separate part of the description (Rule 5.2(a)). In such a case the check-box “The description contains a sequence listing” should be checked.

Please refer to Section 9.1.2 for further details.
8. **DECLARATIONS**

8. Declarations

At the option of the applicant, the Request may, for the purposes of the national law applicable in one or more designated States, contain one or more of the following declarations, using the prescribed standardized wording (Rules 4.1(c)(iii) and 4.17). (For further details, see also Rule 51bis.1, Sections 211 to 215 and the PCT Applicant’s Guide, International Phase. For information on the declarations required by each designated Office, see the PCT Applicant’s Guide in the relevant National Chapter.)

(i) declaration as to the identity of the inventor;

(ii) declaration as to the applicant’s entitlement, as at the international filing date, to apply for and be granted a patent;

(iii) declaration as to the applicant’s entitlement, as at the international filing date, to claim the priority of the earlier application;

(iv) declaration of inventorship (only for the purposes of the designation of the United States of America);

(v) declaration as to non-prejudicial disclosures or exceptions to lack of novelty;
Declaration as to the identity of the inventor (Rules 4.17(i) and 51bis.1(a)(i)):
Such a declaration is not necessary in respect of any inventor who is indicated as such (either as inventor only or applicant and inventor) in the Request form in accordance with Rule 4.5 or 4.6.

Declaration as to the applicant’s entitlement, as at the international filing date, to apply for and be granted a patent ( Rules 4.17(ii) and 51bis.1(a)(ii)):
The possible kinds of transfer of entitlement include merger, acquisition, inheritance, donation, etc. Where there has been a succession of transfers from the inventor, the order in which transfers are listed should follow the actual succession of transfers, and items may be included more than once, as necessary to explain the applicant’s entitlement.

Declaration as to the applicant’s entitlement as at the international filing date, to claim the priority of the earlier application ( Rules 4.17(iii) and 51bis.1(a)(iii)):
This declaration is only applicable where the person or name of the applicant is different from that of the applicant who filed the earlier application from which priority is claimed. For example, this declaration may be applicable where only one applicant out of five is different from the applicants indicated in respect of an earlier application. The possible kinds of transfer of entitlement include merger, acquisition, inheritance, donation, etc. Where there has been a succession of transfers from the applicant in respect of the earlier application, the order in which transfers are listed should follow the actual succession of transfers, and items may be included more than once, as necessary to explain the applicant’s entitlement.

Declaration of Inventorship ( Rule 4.17(iv) and Section 214):
The name, residence, address and citizenship must be included for each inventor. If the Request form is in a non-Latin language, the name and address must also be indicated in the Latin alphabet. All inventors must sign and date the declaration even if they do not all sign the same copy of the declaration (Section 214(b)). Where the declaration was not included in the Request, but is furnished later, the PCT application number MUST be indicated in the appropriate field.

Declaration as to Non-prejudicial Disclosures or Exceptions to Lack of Novelty ( Rule 4.17(v) and Section 215):
The declaration must be worded with such inclusion, omission, repetition and reordering of the matters as listed in the pull-down list as is necessary.
8.1 PREPARING DECLARATIONS

On the Declarations page, use the pull-down list to select a declaration; then click "Add".
Fill in the details by selecting the applicant concerned. The declaration can be previewed by clicking the ‘preview’ speed button in the top left corner of the screen.

Double-click the ‘Add item’ row. In the next screen select the relevant item from the scroll-down menu and confirm by clicking ‘OK’.
When a declaration is prepared at the same time as the Request, to be filed as part of the international application, the radio button (in relation to) “this international application” is automatically selected. The declaration is printed at the same time as the Request form.

To delete a declaration, select it on the list of declarations, right-click and select Cut.

**Declarations after submission**

When a declaration is prepared after the international application has been filed, the radio button (in relation to) “international application No.” is selected by the software in which case the PCT number, if available, should be entered. The "Print Declarations" button is active when declarations are prepared after the submission of an international application. When a declaration is furnished after the international filing date, no further page fee is required.
9. CONTENTS

9.1 CONTENTS (checklist)
9.1 CONTENTS (CHECK LIST)

The Contents Page contains indications relating to various items that are part of, or accompany, the international application. This page comprises two master tables, identified by the following notebook tabs:

- International Application Master Table where indications relating to the contents of the international application itself are entered
- Accompanying Items Master Table where indications relating to items which accompany the international application are entered

Both master tables contain a detail table where details concerning attached paper documents and electronic files can be specified.
9.1.1  International Application Master Table (Check List)

This master table contains the following items:

- Request
- Description/Description (excluding sequence listing part)
- Claims
- Abstract
- Drawings
- Sequence listing part of description (where applicable)

(The item “Sequence listing part of the description” will only appear where the checkbox on the Biology page has been checked.)

Double click a row, or select a row and click the Open button, to indicate the number of pages for the paper document for each item. (Only the Abstract is automatically attached in electronic form and saved with the Request form data on diskette.)

**Completion Tips**

Indication of the number of sheets comprising the description and claims is mandatory. The user must complete these fields.

Once the number of pages of each element of the international application has been entered press the “Calculate” button. The total number of pages of the international application appears just below the Drawings or Sequence listing part of description item, as applicable, on this master table, in the field marked “total”.

9.1.2  Sequence listings

Where the international application contains disclosure of one or more nucleotide and/or amino acid sequences these should be contained in a separate part of the description (Rule 5.2(a)). In such a case the check-box “The description contains a sequence listing” should be checked on the Biology page (see below).

If the sequence listing box is checked on the Biology page this will automatically add:

- One row “Sequence listing part of description” on the International application Contents tab
- Two rows on the Accompanying items master table, respectively “Sequence listing submitted for international search only” and “Statement confirming that the information in the “Annex C/ST 25 text format” submitted under Rule 13ter is identical to the sequence listing as submitted in the international application”.

EFS-Web checkbox (for electronic filings with RO/US): this box is made available when the PCT-EASY filing mode checkbox is selected and it is used to activate the EFS-Web functionality for filings with the United States Patent and Trademark Office (USPTO). For further information on how to use PCT-SAFE for the EFS-Web please see the related User guide on the PCT-SAFE Documentation page at [http://www.wipo.int/pct-safe/en/support/user_documentation.htm](http://www.wipo.int/pct-safe/en/support/user_documentation.htm).
Once the checkbox 'The description contains a sequence listing' is checked on the Biology page, this will add an item 'Sequence listing' to the 'International Application' tab of the 'Contents' section.

9.1.3 The Calculate Button

Once the International Application check list has been completed, press this button to generate a page total. This is a mandatory operation as the total number of pages of the Request form will determine the calculation of the International Filing Fee. You should click the button again (Recalculate) after having either added or deleted information. When the "preparation for submission" procedure is invoked, the page count will automatically be recalculated.
9.1.4 International Application Content Details
9.1.4 International Application Content Details

The user may scroll through items on the Content Details screen using the navigation bar on the left hand side of the screen:

9.1.4.1 Request (including Declaration sheets)

**Paper document:**

The Request form is automatically generated by PCT-SAFE as is the page count for the Request. This number appears in the “Pages” column.

**Electronic file:**

Will be generated by the software as part of the submission process.

9.1.4.2 Description (excluding sequence listing part)

**Paper document:**

To indicate the number of pages of the description (excluding sequence listing part), select the radio button “is enclosed" and enter the number in the edit field. This field is mandatory.

**Electronic file:**

No electronic file is included for description, claims and drawings in PCT-EASY mode.

9.1.4.3 Claims

**Paper document:**

To indicate the number of pages of the claims section, select the radio button “is enclosed” and enter the number in the edit field. This field is mandatory.
9.1.4.4 Abstract

The abstract must consist of a summary of the disclosure as contained in the description, claims, and drawings.
9.1.4.5 Drawings

Where the international application contains drawings, the number of the figure of the drawings which the applicant believes best characterizes the invention should be provided and inserted in the field “Figure of the drawings which should accompany the abstract”. Only one figure should be indicated, if useful for the understanding of the abstract. If none of the figures is useful for the understanding of the abstract, no figure need be indicated. (Rules 3.3(a)(iii) and 8.2)
**Paper document:**

To indicate the number of pages of the drawings, select the radio button “is enclosed” and enter the number in the edit field.

In addition to the indication of the number of pages of drawings and the figure of the drawings which should accompany the abstract in the international publication, it is also possible to indicate if the drawing selected for publication contains text matter. The text matter should be typed in the 'Drawing Text' field. This will facilitate the translation and preparation for international publication.

### 9.1.4.6 Sequence listing part of description

Where the application contains disclosure of one or more nucleotide and/or amino acid sequences, such sequences must be presented as separate parts of the description in accordance with the standard provided in Annex C of the Administrative Instructions ($(http://www.wipo.int/export/sites/www/pct/en/texts/pdf/ai.pdf)$). This item will only become available where the checkbox on the Biology page has been checked.

**Paper document:**

To indicate the number of pages of the sequence listing part of the description, select the radio button “is enclosed” on the Content details screen of the “Sequence listing part of the description” tab and enter the numbers in the edit fields.

**Electronic file:**

Not applicable for the sequence listing part of the description.
9.1.4.7 Sequence listing in PCT-EASY EFS-Web mode (for filing with RO/US)
In PCT-EASY EFS-Web mode (for RO/US) there are three options:

(a) **EFS-Web and text file**: Where the international application is filed via EFS-Web the sequence listing should preferably be furnished as an Annex C/ST.25 text file. When furnished in this manner, the number of sheets of the sequence listing is **not** included in the total number of sheets making up the international application. Whenever the sequence listing is furnished as an Annex C/ST.25 text file, there is no need to file another copy of the text file for search purposes under Rule 13ter since the text file submitted will be used for both disclosure of the international application and for search purposes.

(b) **EFS-Web and image file**: If the sequence listing is filed online via EFS-Web as an image file (e.g. PDF file) the number of sheets of the sequence listing must be included in the total number of sheets making up the international application. Where the sequence listing is filed in image format, a copy of the sequence listing in the form of an Annex C/ST.25 text file (together with the required statement) should accompany the international application as an item in the **Accompanying items** tab of the **Contents** page, if so required by the ISA but **only** for the purposes of international search under Rule 13ter.

(c) **EFS-Web and physical data carriers**: If the text file containing the sequence listing is larger than 100MB, or if the image file (e.g. PDF file) containing the sequence listing is larger than 25MB, the applicant must file the sequence listings as an Annex C/ST.25 text file on physical data carrier(s). The RO/US does not accept the filing of image (e.g. PDF file) on physical data carrier(s). In such cases, the data carrier(s) must be furnished on the same day that the international application is filed online. This may be furnished via “Express Mail Post Office to Addressee” with a date-in by the United States Postal Service the same date as the online filing date, or via commercial delivery services or by hand, provided that it reaches the RO/US on the same day as the international application filed online. The number and type of carrier(s) should be indicated on the ‘Content details’ of the **Sequence listing** row of the **Contents**.

9.1.5 Accompanying Items Master Table (Check List)

![Image of Accompanying Items Master Table]

The image shows a section of the PCT-SAFE User Reference Manual - PCT-EASY Mode, focusing on the Accompanying Items Master Table. The table lists various items such as "Original/Supplementary power of attorney," "Copy of general power of attorney," "Statement explaining lack of signature," "Translation of international application into," and "Sequence listing submitted for international search only." The table also indicates the number of documents and files.
9.1.5 Accompanying Items Master Table (Check List)

On the “Contents” page open the “Accompanying items” tab. Select from the pull-down list the type of item to be added and click the “Add” button. Double click a row, or select a row and click the Open button to indicate that items have been attached. This Master Table may contain the following automatically generated items:

9.1.5.1 Fee calculation sheet

*Paper document:*

Fee sheet is printed as part of the submission process, and should accompany the Request form printout, even if fees are not paid at the time of filing.

*Electronic file:*

Not applicable.

9.1.5.2 Priority document (Contents page) (multiple instance)

As a reminder, a priority document item is automatically added as a row on the Accompanying Items page for each national, regional priority and international claim indicated on the Priority page if the receiving Office has not been requested to prepare and transmit a copy of that document to the International Bureau or if the International Bureau has not been requested to retrieve a priority document from DAS. Please note, however, that such a document is only indicated as attached when such an indication has been made under “Paper document” below.
9.1.5.3 Original separate power of attorney

**Paper document:**
To indicate that this item accompanies the international application, select the radio button “is enclosed.”

**Electronic file:**
Not applicable.

9.1.5.4 Copy of/original general power of attorney

**Paper document:**
To indicate that a copy of a general power of attorney, the original of which has been previously deposited with the receiving Office according to Rule 90.5, accompanies the international application, select the radio button “is enclosed”. If the receiving Office has accorded a reference number to the deposited general power of attorney, that number may be indicated.

**Electronic file:**
Not applicable.

9.1.5.5 Statement explaining lack of signature

**Paper document:**
If the United States of America is designated and an inventor/applicant for that State refused to sign the Request or could not be found or reached after diligent effort, a statement explaining the lack of signature may be furnished. It should be noted that this applies only where there are two or more applicants and the international application has been signed by at least one other applicant. The statement must satisfy the requirements of the receiving Office (Rules 4.1(d) and 4.15).

To indicate that this item accompanies the international application, select the radio button “is enclosed.”

**Electronic file:**
Not applicable.
9.1.5.6 Separate indications concerning deposited microorganisms and/or other biological material

**Paper document:**

Indicate that a paper document is included by selecting the radio button “is enclosed” where a filled-in Form PCT/RO/134 or any separate sheet containing indications concerning deposited biological material is filed with the international application. For certain States (see the *PCT Applicant's Guide*, Annex L), Form PCT/RO/134 or any other sheet containing the said indications must be included as one of the sheets of the description. If the relevant indications (which may be contained on a separate sheet or on Form PCT/RO/134) are part of the international application, no indication should be made for this item. For further information, see Rule 13bis and Section 209.

**Electronic file:**

Not applicable.

9.1.5.7 Sequence listing submitted for international search only (physical medium)

![Image of Content Details window]

Electronic file

- [ ] is not enclosed
- [x] submitted for the purposes of international search only (and not as part of the international application)

Type of carrier:

- [ ] floppy disk
- [ ] CD
- [ ] DVD
- [ ] other

Type number: 1

Sequence listing submitted for international search only

OK Cancel
Electronic file:

To indicate that a sequence listing in the form of an Annex C/ST.25 text file is furnished for the purposes of international search on a physical data carrier such as diskette, CD, DVD or other data carriers accepted by the selected ISA. In such a case, select the radio button “is submitted for the purposes of international search only (and not as part of the international application)” (Rule 13ter) and indicate the type of carrier, e.g. diskette and their number.

9.1.5.8 Statement confirming that the information in the “Annex C/ST 25 text format” submitted under Rule 13ter is identical to the sequence listing as submitted in the international application

When the sequence listing part of the description is submitted on paper, with a copy of the sequence listing as an Annex C/ST.25 file for the purposes of international search, this statement should accompany the international application.

Paper document:

To indicate that this item accompanies the international application, select the radio button “is enclosed”.

Electronic file:

Not applicable.

9.1.5.9 Translation of international application into …

Where a translation of the international application for the purposes of international search (Rule 12.3) accompanies the international application, indicate the language of translation in the <language> field.

Paper document:

To indicate that this item accompanies the international application, select the radio button “is enclosed.”

Electronic file:

Not applicable.

9.1.5.10 OTHER (specify) (multiple instance)

Enter the details of this item in the pull-down menu when the <specify> prompt appears. Select the “Add” button and this other item will be added to the list of accompanying items.

Paper document:

To indicate that this item accompanies the international application, select the radio button “is enclosed.”

Electronic file:

Not applicable.
10. FEES

10.1 FEES (FEE CALCULATION)

The purpose of the fee calculation page is to help the applicant identify the prescribed fees and to calculate the amounts to be paid. Use of this page will help the receiving Office verify fee amounts and help eliminate calculation errors.

Information about the applicable fees payable can be obtained from the receiving Office or on WIPO’s website (http://www.wipo.int/pct/en/fees/index.html). The amounts of the international and search fees may change due to currency fluctuations. Applicants are advised to check what the latest applicable amounts are. All fees must be paid within one month from the date of receipt of the international application.

The Fee Calculation page consists of the following items:

10.1.1 Currency (pull-down menu)

If there is more than one acceptable currency for paying the fees (which depends upon the choice of receiving Office and International Searching Authority indicated on the Request page), the currency for payment may be chosen by the user from the pull-down menu. In some instances there may be two currencies for the same fee schedule. This may occur where some fees (usually the transmittal fee and the fee for priority document) are paid in the local currency and the search fee and international fee are paid in CHF, EUR or USD. It is also possible to have a total fee amount indicated as an equivalent of a CHF (EQF) or USD (EQU) amount, where the corresponding amount.
payable to the receiving Office in a local currency needs to be calculated and manually entered by the applicant.

10.1.2 Fee schedule (pull-down menu)
Selection of a fee schedule from the pull-down menu populates the fee calculation table and the fee sheet.

10.1.3 Updating fee schedule
When fees have changed and there is no software update available, it is possible to update fee schedules manually.

After indicating at least the receiving Office and International Searching Authority on the Request page, select the latest fee schedule on the Fees page. Double-click in the Amount column of the fee to be changed and type the new fee amount. Click in another column of the Fees page to accept the new amount. Click on the Update fee schedule button in the lower right corner of the page. Indicate the effective date for this new fee schedule and click on OK to create a modified fee schedule which will be available in subsequent applications.

10.1.4 Fee Calculation Table

![Fee Calculation Table Image]

- **Transmitted fee**: USD 88
- **Search fee**: USD 2164
- **International Filing Fee**: USD 1184
- **Supplement per sheet over 50**: USD 13
- **EASY Filing reduction**: USD -85
- **Fee for priority document**: USD 0
- **Fee for restoration of right of priority**: USD 0

**Total Fees Payable**: USD 2148
10.1.4 Fee Calculation Table

Fee information is displayed directly on this table. Fee multipliers are automatically calculated from data input on other Request pages. Using the Currency and Fee Schedule pull-down menus, the fee amounts themselves are automatically imported from fee data stored in the Maintenance section of the software. The fee amounts do not include digits after the decimal if they are ‘0’. If these digits need to be displayed it is possible to change the display settings from the File Manager (see chapter 1.8.7.4 for details). Fee amounts can also be input or modified directly on this table by the user. Total amounts are automatically generated. This table consists of the following items:

10.1.4.1 Transmittal fee

This fee is for the benefit of the receiving Office (Rule 14.1). The amount of the transmittal fee, if any, shall be fixed by the receiving Office, and shall be paid within one month from the date of receipt of the international application. Information about this fee is contained in Annex C of the PCT Applicant’s Guide (http://www.wipo.int/pct/guide/en/index.html).

10.1.4.2 Search fee

This fee is for the benefit of the International Searching Authority (ISA) (Rule 16.1). The amount of the search fee is fixed by the ISA and must be paid within one month from the date of receipt of the international application by the receiving Office. Information about this fee is contained in Annex D of the PCT Applicant’s Guide. Please note that where the US has been indicated as the International Searching Authority, and an earlier search has been indicated on the Request page (corresponding to a prior US national application under 35 USC 111(a) that has been filed and the basic fee paid), the Search fee may reflect the reduced amount. For further details on conditions for according a reduction in the search fee amount please contact either the USPTO or the PCT e-Services Help Desk.

10.1.4.3 International Filing fee

The amount of this fee depends on the total number of sheets of the international application, which appears in the “Total” field below the International Application Master Table on the Contents page. If the international application consists of 30 sheets or less, no supplemental fee is charged. This fee must be paid within one month from the date of receipt of the international application by the receiving Office. Information on the amount of this fee is contained in Annex C of the PCT Applicant’s Guide (http://www.wipo.int/pct/guide/en/index.html).

10.1.4.4 International Filing fee: Supplement per sheet over 30

If the international application consists of more than 30 sheets, a supplement fee per sheet over 30 is charged. If this is the case, the total number of sheets over 30 will automatically appear as the multiplier for this fee. This fee must be paid within one month from the date of receipt of the international application by the receiving Office. Information on the amount of this fee is contained in Annex C of the PCT Applicant’s Guide.

10.1.4.5 International filing fee: EASY filing reduction

A reduction of 100 Swiss francs of the international fee (or the equivalent in the currency in which the international fee is paid to the receiving Office) is available if the following two conditions are met: (i) the international application must be filed with a receiving Office which is prepared to accept the filing of PCT-EASY international applications;
and (ii) the Request form must be presented as a computer print-out prepared using PCT-SAFE software and filed together with a physical medium, containing a copy in electronic form of the data contained in the Request and of the abstract as a text (.txt) file.

| Important: Where the abstract has been added in electronic format on the Contents page, the amount of the fee reduction will appear as a negative amount in red. Where the abstract has not been attached in electronic form, the amount of the fee reduction will appear as “0”. |

10.1.4.6 Fee for priority document

Where the authority with which the earlier application was filed is the same office as the receiving Office, the applicant may, instead of submitting the priority document, request the receiving Office to prepare and transmit the priority document to the International Bureau. Such request may be made by marking the applicable check-box on the Priority Details page where the applicant identifies such document. Where such a request is made, the applicant must, where applicable, pay to the receiving Office the priority document fee which may be entered here (for information, see Annex C of the PCT Applicant’s Guide). (Rule 17.1(b)) The multiplier for the priority document fee corresponds to the number of requests for such documents that have been made on the Priority Details pages.

If that fee is not paid at the latest before the expiration of 16 months from the priority date, the receiving Office may consider the request under Rule 17.1(b) as not having been made.

If the receiving Office does not have a flat fee per priority document requested (e.g. amount depends on number of pages) this field will also contain the indication “(total amount)”. In such a case, the priority document multiplier will be disabled (always indicating “1” irrespective of the number of priority documents requested). The user should calculate the total fee amount for all priority documents requested and enter the total in the “Amount” column.
10.1.4.7 Reduction of fees for applicants from certain States

PCT-SAFE performs a validation to assess if all applicants indicated have the right to claim the fee reduction according to the conditions indicated below.

Where a fee schedule has been selected on the Fees page, reductions will automatically be calculated where applicable. In such a case the multiplier column (X) on the Fees page will indicate the reduction applied in brackets in red. Please note that the International Filing fee: electronic filing reduction will also be reduced accordingly.

Where the amounts in the fee schedule have not been predetermined (due to local currency fluctuations) the correct amounts should be confirmed with the receiving Office and the full (non-reduced) amount should be indicated in the Amount column.

Reduction of the International Filing Fee for Applicants from Certain States: An applicant who is a natural person and who is a national of and resides in a State whose per capita national income is below 3,000 US dollars (according to the average per capita national income figures used by the United Nations for determining its scale of assessments for the contributions payable for the years 1995, 1996 and 1997), or who is a national of and resides in one of the following States: Antigua and Barbuda, Bahrain, Barbados, the Libyan Arab Jamahiriya, Oman, the Seychelles, Singapore, Trinidad and Tobago and the United Arab Emirates; or an applicant, whether a natural person or not, who is a national of and resides in a State that is classed as a least developed country by the United Nations, is entitled, in accordance with the Schedule of Fees, to a reduction of 90% of certain PCT fees including the international filing fee. If there are several applicants, each must satisfy the above-mentioned criteria. The reduction of the international filing fee will be automatically available to any applicant (or applicants) who
is (or are) so entitled on the basis of the indications of name, nationality and residence
given in the ‘Names’ section of the request. The fee reduction is available even if one or
more of the applicants are not from PCT Contracting States, provided that each of them
is a national and resident of a State that meets the above-mentioned requirements and
that at least one of the applicants is a national or resident of a PCT Contracting State
and thus is entitled to file an international application.

Information about PCT Contracting States whose nationals and residents are entitled to
a reduction of 90% of certain PCT fees, including the international filing fee, is contained
in the PCT Applicant’s Guide, Annex C and on the WIPO website (see
www.wipo.int/pct/en/), and is also published and regularly updated in the Official Notices
(PCT Gazette) and the PCT Newsletter. As far as other States are concerned, further
information can be found at http://www.wipo.int/pct/en/fees/fee_reduction.pdf. Other fee
reductions may also be available for applicants from Certain States. Please check with
the receiving Office to see which other reductions may apply. In such cases, the
applicant should indicate the reduced fee amount, where applicable, on the Fee
Calculation Page.
11. PAYMENT

11.1 PAYMENT

This page allows the applicant to indicate the mode of payment of the prescribed fees, which can be selected from the pull-down menu. Not all modes of payment may be available at all receiving Offices.

Note concerning authorization to charge accounts: The receiving Office will not charge fees to current/deposit accounts unless the account authorization is signed (on the Fee Calculation sheet printout) and indicates the account number (entered in the edit field provided when this mode of payment has been selected).
11.1.1 In addition, indicate current account authorization (check-box)

If the user wishes to indicate a current account authorization in addition to another mode of payment as a precaution, check this box and indicate the current account number in the field provided.

11.1.2 Payment at RO/IB

For detailed information on credit card (e-payment) mode of payment with WIPO’s receiving Office RO/IB, or on how to open a current account at WIPO please visit: http://www.wipo.int/pct/en/filing/modes.html
12. ANNOTATE

The Annotate Table contains the “Signature of Applicant or Agent” function, used to create a list of signatories, and the “Validation Log”, which allows the user to view all outstanding validation messages in the request form being prepared.

This table may also be used to include additional indications, if any, relating to the international application, and consists of the following functions:

- Inventor for certain designated States only
- Remarks
- Private remarks

When selected from the pull-down menu, items appear as entries on the Annotate Table. Select the item to view or edit.
12.1.1 Remarks

This item is for the input of any additional information or remarks which the user wishes to communicate to the receiving Office when submitting the international application. This information will be included in the Validation lo). (The Remark functionality corresponds to the Supplementary sheet in the Request form PCT/RO/101.)

Remarks can also be made from, and associated with, any Request form page by selecting the Remarks command from the Edit menu.

12.1.2 Private remarks

This item is for the input of remarks which the user does not wish to communicate to the receiving Office when submitting the international application. These remarks may serve as a reminder to the user when returning to an incomplete application or as a communication to another user involved at a different stage of the preparation. This information is not included in the submission file; it will only appear on the Annotate page.

Private remarks can also be made from any page by selecting Private remarks from the Edit menu.

12.1.3 Inventor for certain designated States only

Different persons may be indicated as inventors for different designated States (e.g., where, in this respect, the requirements of the national laws of the designated States are not the same); in such a case, select this item from the Annotate pull-down menu and click the “Add” button. Upon selection, a table containing a list of all inventors indicated on the Names page appears. Double-click the column “for the Purposes of” to the right of the person’s name and indicate those States for which this person is to be considered inventor by selecting them from the complete list of designated States that appears. In the absence of any indication, it will be assumed that the inventor(s) named is (are) inventor(s) for all designated States. (Rule 4.6(c))
12.1.4 Signature of Applicant or Agent

Here the user can create a list of persons who will sign the Request form printout. To create such a list, select the person (or persons) from the upper list—in the case of a legal entity also enter the name and capacity of the person signing (if such capacity is not obvious from reading the Request)—in the fields provided. Click on the “Insert” tab and repeat this process for each person signing the request form printout. Selected persons are added to the list at the bottom of the table. Where there are several entities on the list, the Move Up button can be used to rearrange the order. The Delete button can be used to delete an entity which has been selected.

Under PCT Rule 4.15, each applicant should sign the Request. If there is more than one applicant, it will be sufficient, however, for the purposes of filing the international application, if the Request is signed by one of them (Rule 26.2bis(a)). The signature may be that of the agent or common representative where a separate power of attorney appointing the agent or common representative, or a copy of a general power of attorney already in the possession of the receiving Office, is furnished. If the power is not attached to the Request, the receiving Office may invite the applicant to furnish it subsequently unless it has waived the requirement (Rules 90.4(d) and 90.5(c)).

If the United States of America is designated and an inventor/applicant for that State refused to sign the Request or could not be found or reached after diligent effort, a statement explaining the lack of signature may be furnished. It should be noted that this applies only where there are two or more applicants and the international application has been signed by at least one applicant. The statement must satisfy the requirements of the receiving Office. If such a statement is filed with the international application, the item “Statement explaining lack of signature” should be selected from the Accompanying Items Master Table (Contents page). (Rules 4.1(d) and 4.15)

If “authorization to charge current account” has been selected as the Mode of Payment, an additional field will appear on the “Annotation edit dialog” box where the name of the authorized signatory for the current/deposit account can be entered.
The Signature screen also contains optional fields where the user can indicate an ePCT Customer ID and ePCT eOwnership code so that eOwnership will be assigned to that account holder (even if this person is not a signatory) when the international application is processed at the International Bureau. The eOwnership details will not appear on the request form print-out but will be stored in the background in an xml file for loading into the International Bureau’s electronic processing system.

This feature is available as of the April 2012 version of PCT-SAFE client software. A precondition for this process is that the user has a valid WIPO Account, which is associated with a valid digital certificate, for access to ePCT Private Services. For full details please see the User guide “Assign eOwnership in ePCT at the time of filing using PCT-SAFE“ available at http://www.wipo.int/pct-safe/en/support/user_documentation.htm. Detailed instructions on how to create a WIPO Account and authenticate it for access to ePCT Private Services can be found on the ePCT website at https://pct.wipo.int/ePCT.

The Signature screen also contains optional fields where the user can indicate an ePCT Customer ID and ePCT eOwnership code so that eOwnership will be assigned to that account holder (even if this person is not a signatory) when the international application is processed at the International Bureau. The eOwnership details will not appear on the request form print-out but will be stored in the background in an xml file for loading into the International Bureau’s electronic processing system.

This feature is available as of the April 2012 version of PCT-SAFE client software. A precondition for this process is that the user has a valid WIPO Account, which is associated with a valid digital certificate, for access to ePCT Private Services. For full details please see the User guide “Assign eOwnership in ePCT at the time of filing using PCT-SAFE“ available at http://www.wipo.int/pct-safe/en/support/user_documentation.htm. Detailed instructions on how to create a WIPO Account and authenticate it for access to ePCT Private Services can be found on the ePCT website at https://pct.wipo.int/ePCT.
13. PREPARATION FOR SUBMISSION

13.1 READY TO SUBMIT

The Ready to submit folder contains PCT Request forms that have been prepared for submission but have not yet been copied to diskette for transmittal.

13.1.1 Copying an application file to diskette

When finalizing a PCT-EASY application for submission, insert a blank formatted diskette in the a:\ drive, then double click the PCT-SAFE application to be copied to diskette from the “Ready to submit” folder information viewer. At this point a “Save As” dialog box appears. Select “Save”, change the drive path if necessary. The zip file will be copied to diskette and saved to the “Submitted” folder of the File Manager for later reference.

The diskette containing the zip file should be labeled “PCT-EASY”, also write the applicant’s or agent’s file reference, and the first applicant’s name on the label. The diskette should be transmitted to the receiving Office with the international application in paper form.

If the receiving Office selected permits it, physical media other than diskette may also be used for submitting the Request form data and abstract in electronic form. Select the application in the “Ready to submit” folder, change the drive path if necessary to save it and then proceed the usual way to create a CD or DVD. For acceptable media options please refer to Appendix IV of Annex F of the Administrative Instructions [http://www.wipo.int/pct/en/texts/pdf/ai_anf.pdf](http://www.wipo.int/pct/en/texts/pdf/ai_anf.pdf).

13.1.2 Viewing an application in the Ready to submit folder

Highlight the desired application from the “Ready to submit” folder, right-click and select “View/Edit”. The locked application will then open for viewing.
13.1.3 Correcting an error or omission in an application ready for submission

Highlight the form in the Ready to submit folder, right-click and select “Return to drafts” to modify the form if an error or an omission is discovered at this time.

13.1.4 Deleting forms from the Ready to submit folder

Should it be necessary to delete an application prepared for submission, highlight the desired application from the “Ready to submit” folder, right-click and select “Delete”.

13.2 PREPARATION FOR SUBMISSION

This function takes the user through the steps to finalize a PCT-EASY application for submission to the receiving Office: verifying the content of the request form and abstract, indication of the signatory, printing the form and copying the electronic file to a data carrier.

**Important**: Before proceeding, the user should verify the data by previewing and/or printing a draft copy of the filled-in request form (accessed from the speed buttons or File menu). If an error or an omission is discovered at this time, highlight the form in the Ready to submit folder, right-click and select “Return to drafts” to modify the form.

13.2.1 Starting the Preparation for Submission process

Click the “Save as ready for submission” speed button from the speed button group found at the top left corner of the Request form page or select “Save as ready for submission” from the File menu.

Please note that this button and command can only be selected when all “Red” validation messages relating to the data entered for this international application have been cleared.

The abstract viewer will open for the user to verify the text input. Click “OK” to confirm the abstract data. Upon confirmation the Validation information dialog box appears showing validation messages for each page of the Request form.
13.2.2 Confirmation

Scroll down to carefully review the validation log, which contains important information about your PCT-EASY filing. Select “Cancel” to correct any errors or make any changes before proceeding. If the validation log is acceptable, select “OK” and follow further prompts to proceed.
13.2.3 Signature

Sign the request form unless it has already been signed as indicated earlier. It is also possible at this point to modify the details of the Signature of the Applicant or Agent made earlier.

Select “OK” to continue with the submission process.
13.2.4 Submission Log

The submission log displays the progress of the submission process. It also indicates the date of preparation, the submission file name and the “Method of Submission”. Click on “Continue” for the “Signature of the Applicant or Agent” dialog box to appear.
13.2.5 Printout of the Request Form and Other Forms

The print dialog box appears as part of the submission process.

Before selecting the “OK” button to print, verify that your printer is on-line and loaded with A4 size paper (different from 8 1/2”x11” or “letter” size). Also verify that the correct paper size is indicated in your print setup (accessed by selecting the “Properties” button from the Print dialog box).

The request form and fee sheet printout generated as part of the submission process is identified with the indication “Original (for submission)” in the header of each printed page. (This printout differs from the one generated using the Print speed button or File menu command in that the latter is identified with the indication “Draft (Not for submission)”).

The validation log is also printed and it should be submitted with the application. It contains a list of outstanding validation messages which should be reviewed carefully. It is not necessary to submit the abstract printout generated at this point.

If the user has made indications relating to a deposited microorganism and/or other biological material on the “Biology” page, a printout of form PCT/RO/134 indications will also be included.

Once the Request form has been printed, click “Continue” to proceed with the submission process. The following information message appears telling the user to go the “Ready to submit folder”: 
Your application has been stored in the database. To save to a physical medium for submission please go to the "Ready to submit" folder of the PCT-SAFE File Manager and double-click on your application (or alternatively select "Submit" from the context menu).
13.2.6 Creating and Copying the Zip File to Diskette
13.2.6 Creating and Copying the Zip File to Diskette

After closing the Submission Log and clicking on “Continue”, the PCT-EASY form may now be copied to diskette for submission. Insert a blank formatted diskette in the a:\ drive. From the Ready to submit folder, highlight the form that is ready for submission, right-click and select “Submit”. The “Save as” dialog box appears and the zip file can be copied to diskette. It will then move to the “Submitted” folder in the PCT-SAFE File Manager.

Diskette label

The diskette containing the zip file should be labeled “PCT-EASY”, also write the applicant’s or agent’s file reference, and the first applicant’s name on the label. The diskette should be transmitted to the receiving Office with the international application in paper form.

13.2.6.1 Correcting an error or omission from an application that has already been prepared for submission (but not transmitted to the Receiving Office)

If an error or an omission is discovered after the preparation for submission process has been completed, highlight the Request form in the ‘Submitted’ folder, right-click and select “Return to drafts” to modify the form and then go through the submission process again.
Submitted Forms

13.2.7 Submitted Forms
The Submitted Forms folder contains PCT-EASY Request forms that have been prepared for submission and have already been copied to physical medium.

13.2.7.1 Viewing an application in the Submitted folder
Double-click the relevant PCT-SAFE application in the “Submitted” folder to view it. The locked application will then open for viewing. Use the “print preview” speed button to preview the Request form in PDF format. It can also be printed from the PDF viewer window using the “print” speed button at the top left corner of the window.

It is also possible to view the Request form, fee sheet, validation log etc. in PDF format by selecting View ‘by document’ in the upper right corner of the File Manager screen, and clicking on the + next to a file reference.

13.2.7.2 Printing duplicates of the forms printed during submission
If necessary, the forms printed during the submission process can be reprinted. Double-click the relevant PCT-SAFE application in the Submitted forms folder. The locked application will then open for viewing. Select the print speed button or the Print command from the File menu.

The Request form reprinted after the submission process is identified with the indication “Duplicate of Original” in the header of each printed page. In the absence of the original printed forms, duplicates from a locked application may be submitted.
13.2.7.3 Resending to diskette
Right-click the Request in the Submitted folder and select option Resend if a new
 diskette is required.

13.2.7.4 Adding International Application Number and International Filing Date to a submitted
 application
This information may be added to help identify applications in this folder. To add these
details, double-click the Submitted application. Go to the Annotate page and select
“Receipt information” from the “Annotation or Remark” pull-down menu, then select the
“Add” button. Enter the information in the fields provided.

13.2.7.5 Deleting files from the Submitted folder
Right-click the selected application and select “Delete”.

13.2.7.6 Declarations and power of attorney prepared after submission
Declarations and Power(s) of attorney can be prepared after submission of the
international application from the “Submitted” folder. For further details see chapters
5.1.5.6 (Power of attorney) and 8.1 (Preparing declarations).

13.3 USEFUL LINKS
- PCT-SAFE Homepage: (http://www.wipo.int/pct-safe)
- ePCT: https://pct.wipo.int/LoginForms/epct.jsp for ePCT private online services that
  enable access to international applications that are owned or managed by you, and
  ePCT public online services with no access to confidential documents or data.
  Both allow submission of post-filed documents to the International Bureau and to the
  receiving Office of the International Bureau.
- PCT Resources and legal texts: http://www.wipo.int/pct/en/
- PCT-SAFE Contact page: http://www.wipo.int/contact/en/area.jsp?area=patentscope

For further PCT-SAFE material, please visit the Support for PCT Applicants
Section http://www.wipo.int/pct-safe/en/support/user_documentation.htm of
our website.

End of the document